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Introduction
Cisco TelePresence Management Suite Extension for Microsoft Exchange (Cisco TMSXE) is an extension 
for Cisco TelePresence Management Suite that enables videoconference scheduling via Microsoft Outlook, 
and replicates Cisco TMS conferences to Outlook room calendars.

This deployment guide describes how to prepare for, set up, and configure a new deployment, as well as 
upgrading from a previous version of Cisco TMSXE, and troubleshooting issues that may arise during 
deployment or general operation.

Related documents

The following table lists documents and websites referenced in this document, and other supporting 
documentation. All documentation for the latest version of Cisco TelePresence Management Suite 
Extension for Microsoft Exchange can be found at: www.cisco.com/en/US/products/ps11472/tsd_products_
support_series_home.html

Title Link

Cisco TelePresence Management Suite Extension for Microsoft Exchange Software Release Notes 
(4.1)

cisco.com

Cisco TelePresence Management Suite Extension for Microsoft Exchange User Guide (4.1) cisco.com

Cisco Telepresence Management Suite Booking API Programming Reference Guide cisco.com

Training

Training is available online and at our training locations. For more information on all the training we provide 
and where our training offices are located, visit www.cisco.com/go/telepresencetraining

Glossary

A glossary of TelePresence terms is available at: tp-tools-web01.cisco.com/start/glossary/
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Prerequisites
This section details the prerequisites and best practices for installing  Cisco TMSXE4.1, whether performing 
a new installation or upgrading from a previous version of the product.

Estimating your deployment size
The requirements for Cisco TMS depend on and grow with the size and complexity of the deployment.  The 
complexity of an installation is driven primarily by the volume of activity and number of endpoints controlled 
by and bookable in Cisco TMS. 

Use the following chart  to identify the relative size of your deployment. If your intended deployment  matches 
multiple level criteria, apply the highest level.

 Regular and Cisco 
BE6000

Large

Cisco 
TMS

 n < 200 controlled 
systems

 n < 100 concurrent 
participants

 n < 50 concurrent 
ongoing scheduled 
conferences

 

 n < 5000 controlled systems
 n < 1800 concurrent participants
 n < 250 concurrent ongoing scheduled conferences

Cisco 
TMSXE

< 50 endpoints 
bookable in Microsoft 
Exchange

< 1800 endpoints bookable in on-premises Microsoft Exchange
or
< 1000 endpoints bookable in Office 365 or a combination of on-premises 
Exchange and Office 365
Note that with Office 365, latency towards Exchange is likely to be greater 
than for an on-premises deployment. This may lead to Cisco TMSXE 
occasionally saving a booking before all related events have been 
processed. Users will then receive multiple email notifications for the same 
booking. 

Cisco 
TMSPE

 n < 1000 
Collaboration 
Meeting Rooms

 n < 2000 Cisco VCS-
provisioned users 
(Note: Cisco VCS 
provisioning not 
supported on 
BE6000)

 

 n < 48,000 Collaboration Meeting Rooms
 n < 100,000 Cisco VCS-provisioned users

Co-
residency

All three applications 
and Microsoft SQL 
Server may be co-
resident.

 n Cisco TMSXE must be on a dedicated server.
 n Cisco TMS and Cisco TMSPE must use an external SQL Server.

Other factors that influence Cisco TMS performance and scale include:
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 n The number of users accessing the Cisco TMS web interface.
 n Concurrency of scheduled or monitored conferences.
 n The use of ad hoc conference monitoring.
 n Simultaneous usage of Cisco TMSBA by multiple extensions or custom clients. Booking throughput is 

shared by all scheduling interfaces including the Cisco TMS New Conference page.

Actual booking speed will vary based on the meeting size, features, and schedule complexity around the 
meeting.

Hardware requirements
Find the appropriate hardware requirements below based on your estimated deployment size. 

All applications including SQL Server may also be installed on virtual machines with specifications 
corresponding to these hardware requirements

Regular deployment and Cisco Business Edition 6000
In a regular deployment, Cisco TMS and extensions can be co-located on the same server.

 Requirement Cisco BE6000

CPU 2 cores (Xeon 2.4 GHz or larger), dedicated 1 vCPU 

Memory 8 GB, dedicated 4 GB vRAM, dedicated 

Disk space provided on 
server

60 GB 60 GB

Note that Cisco TMSPE on Cisco Business Edition 6000 does not include Cisco VCS-based user 
provisioning for endpoints or FindMe.

Large deployment
In a large deployment, Cisco TMSXE and SQL Server must be external, while Cisco TMS and Cisco TMSPE 
are always co-resident.

Cisco TMS and Cisco TMSPE server

 Requirement

CPU 2 cores (Xeon 2.4 GHz or larger), dedicated

Memory 8 GB, dedicated

Disk space provided on server 80 GB

Cisco TMSXE server

The requirements for this server correspond to the recommended hardware requirements for the supported 
operating systems.
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Recommended Cisco TMS configuration changes

To decrease the load on SQL Server and Cisco TMS services in a large deployment, we strongly recommend 
the following settings :

 n Administrative Tools > Configuration > Conference Settings: Set Default Reservation Type for 
Scheduled Calls to One Button To Push

 n    Administrative Tools > Configuration > General Settings: Set Route Phone Book Entries to No
 n     Administrative Tools > Configuration > Network Settings: Set Enable Ad Hoc Conference 

Discovery to Only for MCUs or No.

Cisco TMSXE server software requirements
The software requirements are independent of the size of your deployment. For size-appropriate hardware 
requirements, see Estimating your deployment size [p.7] and Hardware requirements [p.8].

Software

Product Version

Microsoft Windows Server  n 2012 up to build 9600
 n 2008 Service Pack 2 (64-bit)
 n 2008 R2 Service Pack 1

Microsoft .NET Framework  n .NET Framework Full (extended) is required
 n Version 4.0 or later

Table 1: Software requirements for the Cisco TMSXE server

Active Directory and DNS
Active Directory system requirements correspond to AD requirements for Exchange.

The Cisco TMSXE server must:

 n be configured to use a DNS server with service records for the Active Directory domain of the Exchange 
server.

 n have network access to Active Directory, meaning no firewall must be blocking traffic, and LDAP and 
Global Catalog must be open. The communication will be authenticated using the Cisco TMSXE Exchange 
service user account. For account setup instructions, see Creating a Cisco TMSXE service user in Active 
Directory [p.25].

Updating the Display Name of an Active Directory account requires restarting the Cisco TMSXE Windows 
service for the new name to be applied.

Cisco TMS Booking Service requirements
In order to use WebEx Productivity Tools with TelePresence, you must include Cisco TMS Booking Service 
when installing Cisco TMSXE. Booking Service uses IIS, the Windows Server web server.
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For Booking Service to work, you must enable HTTPS for Default Web Site in IIS on the server where Cisco 
TMSXE and Booking Service are both installed. In a redundant deployment, this must be done on both 
nodes.

If IIS is not present on the server prior to installation, it will be automatically installed with Booking Service. 
You must then configure HTTPS for Default Web Site after installation.

For further detail, see Configuring IIS for HTTPS [p.49].

Cisco TMS requirements

Version 14.5

Network HTTPS (recommended) or HTTP connectivity is required from the Cisco TMSXE server to Cisco TMS.

Table 2: Requirements for the Cisco TMS server

Licensing requirements
Each telepresence endpoint to be booked through Cisco TMSXE must already have been added to Cisco 
TMS and licensed for general Cisco TMS usage.

Additionally, in order to use Cisco TMSXE for booking these endpoints, you must have one of the following:                     

 n One Cisco TMSXE – Extension for Microsoft Exchange  option key per 25 telepresence endpoints 
integrated with Cisco TMS, usually recommended for smaller deployments. See below for detail on how 
system licenses are activated.

 n One Application Integration Package option key per Cisco TMSXE installation. This option is 
recommended for deployments with a large number of endpoints.

If both license keys are present, Cisco TMS will only use the Application Integration Package key.

Enabling option keys

To enable an option key in Cisco TMS:

 1. Go to Administrative Tools > Configuration > General Settings.
 2. In the Licenses and Option Keys pane, click Add Option Key.
 3. Input the option key string.
 4. Click Save.

Per system licensing

Once the per system option key has been activated in Cisco TMS, the Allow Remote Bookings setting 
determines whether each system is using a license. 

This setting is void and hidden if the Application Integration Package option is used. If both option keys are 
added, only the Application Integration Package option will be used by Cisco TMS.

The first time a system is booked through Cisco TelePresence Management Suite Extension Booking API, 
Allow Remote Bookings will be toggled to Yes for that system in Cisco TMS, provided a license is 
available. If no more licenses are available, Allow Remote Bookings will be left as No for that system, and 
the requested booking will be denied. A Cisco TMS ticket will be generated to notify the administrator that no 
more licenses are available.
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Note that Cisco TMSXE performs a test bookings as each endpoint is added through the configuration tool, 
thus also enabling Allow Remote Bookings.

To view and/or modify the setting:

 1. In Cisco TMS, go to Systems > Navigator.
 2. Select the system you want.
 3. Click the Settings tab.
 4. In the            TMS Scheduling Settings pane, you will find Allow Remote Bookings.

If the setting is Yes, the system is currently using an Exchange Integration Option license.
 5. To disable the setting:

 a. Click Edit Settings.
 b. Uncheck Allow Remote Bookings.
 c. Click Save.

Cisco Collaboration Meeting Rooms Hybrid requirements
In order to use Cisco TMSXE to book meetings that include WebEx, Cisco TMS must be set up with:

 n one or more WebEx sites
 n WebEx credentials for each user (not service user), either manually added or using WebEx/Cisco TMS 

single sign-on

For guidance on setting up Cisco Collaboration Meeting Rooms Hybrid with or without single sign-on, see 
Cisco Collaboration Meeting Rooms Hybrid Configuration Guide.

Microsoft Exchange requirements

Requirement Description

Microsoft 
Exchange

Tested versions:
 n Microsoft Exchange 2013 and 2013 Service Pack 1.
 n Microsoft Office 365 for enterprise (Exchange online) up to and including version 

15.0.898.9. We will test new versions as they are made available to us.                                 
To find out which exact version of Office 365 your organization has, follow these 
instructions from Microsoft:
Verify Office 365 tenant version and status

 n Microsoft Exchange 2010 Service Pack 3.
 n Microsoft  Exchange 2007 Service Pack 3

Windows Server Tested versions:
 n Microsoft Windows Server 2012
 n Microsoft Windows Server 2008 R2
 n Microsoft Windows Server 2008

Exchange Web 
Services (EWS) 

Must be enabled on the Exchange server.

Table 3: Requirements for the Microsoft Exchange server
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Requirement Description

Active Directory Must be available on premises.
If using Office 365, Active Directory Federation Services and the Windows Azure Active 
Directory Sync tool  are required.

Table 3: Requirements for the Microsoft Exchange server (continued)

Client Access Server redundancy and Autodiscover
Cisco TMSXE supports multiple Client Access Servers (CAS) using:

 n Autodiscover, which  must be enabled both in the Exchange environment and in the Cisco TMSXE 
configuration tool.

 n A network load balancer (NLB):
 l With Exchange 2010, the NLB must be set up to use exchangeCookie or have a sticky IP connection 

(affinity) to one CAS server.
 l With Exchange 2007, the NLB must be set up to have a sticky IP connection (affinity) to one CAS 

server.
 l In the case of a CAS failover (2010 and 2007) or mailbox failover (2013), performance will be impacted 

during re-subscription.  If the network load balancer cannot reach the primary CAS, Cisco TMSXE will be 
redirected to another CAS and re-subscribe to resource mailboxes, as subscriptions are stored per CAS 
instance (2010 and 2007) or mailbox server (2013).

 l For guidance on configuration, see the TechNet article Load Balancing Requirements of Exchange 
Protocols.

Certificate authentication
Optionally, the Cisco TMSXE service user can authenticate with Exchange and Active Directory using a 
client certificate and password rather than a username and password.

 n The Exchange CAS must be configured to use client certificate authentication. See Exchange 
documentation for instructions.

 n You must have a valid Personal Information Exchange (PKCX #12)  (.pfx) client certificate that is reachable 
from the Cisco TMSXE file system.

Client requirements
Cisco TMSXE has been tested with the following clients and Exchange versions:

Client Exchange version(s)

Office 365 Office 365

Microsoft Outlook 2013 Office 365 and Exchange  2013
Note that Productivity Tools are not supported with Office 365 and Outlook 2013.

Outlook Web App Exchange 2010 and 2013

Microsoft Outlook 2010 Exchange 2010

Microsoft Outlook 2007 SP2 Exchange 2007

Table 4: Exchange server and client versions

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 12 of 82

Prerequisites

http://technet.microsoft.com/en-us/library/ff625248.aspx
http://technet.microsoft.com/en-us/library/ff625248.aspx


Advanced settings are available with the Cisco TelePresence form, which can only be used with a local 
Outlook client for Windows.

Before installing Cisco TMSXE 4.1, make sure both Outlook and Exchange are already set up so that users 
are able to book meetings that include room mailboxes.
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Deployment scenarios and best practices
This section discusses the supported deployment scenarios for Cisco TMSXE, and the features, limitations, 
and best practices to observe with each scenario.

Cisco Collaboration Meeting Rooms Hybrid deployments
Cisco Collaboration Meeting Rooms Hybrid can be used with Cisco TMSXE and any supported version of 
Exchange, allowing users to book telepresence meetings with a WebEx component directly from their mail 
client.

There are two ways to book Cisco Collaboration Meeting Rooms Hybrid meetings with Cisco TMSXE: the 
WebEx Scheduling Mailbox and WebEx Productivity Tools with TelePresence.

 n For requirements, see Cisco Collaboration Meeting Rooms Hybrid requirements [p.11].
 n For an overview of  the entire Cisco Collaboration Meeting Rooms Hybrid solution, see Cisco Cisco 

Collaboration Meeting Rooms Hybrid Configuration Guide.

The WebEx Scheduling Mailbox
The WebEx Scheduling Mailbox can be used to schedule Cisco Collaboration Meeting Rooms Hybrid 
meetings with any version of Exchange, by adding a special email address to the meeting invite.

For setup instructions, see Setting up the WebEx Scheduling Mailbox [p.46].

WebEx Productivity Tools with TelePresence
Productivity Tools let users book telepresence with WebEx from Outlook and modify advanced settings for 
both components.

Using Productivity Tools with Cisco TMSXE requires the installation and configuration of Cisco TMS 
Booking Service. 

For setup instructions, see Setting up WebEx Productivity Tools with TelePresence with Cisco TMSXE 
[p.48].

Delegates for room mailboxes are supported  with Cisco TMSXE, but not if Productivity Tools are used with 
Outlook.

For limitations on Productivity Tools and versions of Exchange and Outlook, see the documentation for your 
version of WebEx Meeting Center.

On-premises Exchange deployments
Cisco TMSXE can be deployed entirely with on-premises Exchange servers. For version requirements, see 
Microsoft Exchange requirements [p.11].

For environments that mix on-premises  Exchange with Office 365, see Hybrid deployments [p.15].

Limitations with Exchange 2007
Some newer features are not available or supported for Exchange 2007 deployments with Cisco TMSXE:
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 n clustering of the Cisco TMSXE services
 n autodiscovery of the Client Access Server (CAS Autodiscover)
 n resource mailbox impersonation
 n hybrid deployments where CAS and/or mailbox servers are in the cloud

Support for Exchange 2007 will be discontinued in a future release.

Mixed Exchange environments
Combining Exchange servers with different supported versions of Exchange in the same deployment is 
supported, provided CAS autodiscovery is enabled and all CAS servers are running Exchange 2013 or 2010.

Microsoft Office 365 deployments
Cisco TMSXE supports Office 365-based deployments with both CAS and mailbox servers in the cloud. For 
all deployments, Active Directory must be on premises in order to work with Cisco TMS.

Limitations
 n Office 365 plans for small businesses are not supported with Cisco TMSXE due to the limited feature sets 

available with these subscription models.
 n Access to advanced telepresence settings and WebEx Productivity Tools with TelePresence requires a 

local Outlook client.             
Users who only have webmail access can book Cisco Collaboration Meeting Rooms Hybrid meetings 
using the WebEx Scheduling Mailbox.

Hybrid deployments
Office 365 may be deployed in combination with on-premises Exchange servers. Cisco TMSXE supports 
combining Exchange servers on-premises and in the cloud provided that:

 n On-premises Exchange servers are either Exchange 2013 (recommended) or Exchange 2010.
 n Active Directory is on premises, which is required to work with Cisco TMS.
 n All users are in the same environment (on premises or Office 365) as the room mailboxes they will book, 

and the WebEx Scheduling Mailbox, if applicable. This is due to a Microsoft limitation on hybrid 
deployments. Note that the same service user can be used cross premises. For more information on these 
Microsoft limitations, see the Microsoft support article Cross-premises Calendar editing is unavailable in a 
hybrid deployment of Exchange Online in Office 365 and on-premises Exchange Server.

Note that the above limitations on cross-premises booking also apply to environments where Exchange is 
transitioning from on-premises to cloud or from cloud to on-premises.

Making sure rooms are visible to all mailboxes
For cross-premises visibility of calendars:

 n Create the service user, the WebEx Scheduling Mailbox, and all room mailboxes on an on-premises server.
 n Move these mailboxes to the cloud using any of Microsoft's standard procedures or tools.
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Redundant deployments
Clustering and load balancing as described below are supported with Exchange 2010 and later.

Cisco TMSXE service clustering
Active/passive redundancy for the Cisco TMSXE service is supported through clustering. Clustering support 
must be enabled when Cisco TMSXE is installed on the first node.

The nodes will share configuration and data folders, but write their logs to separate locations. Which node is 
currently active/passive is written to the log on INFO level. Note that for any troubleshooting situation, both 
logs will be required.

If one node goes down, the other will automatically become active. A failover may be forced by stopping the 
service on the active node, or rebooting the server.

For prerequisites and setup instructions, see Installing Cisco TMSXE with service clustering [p.39].

Cisco TMS Booking Service redundancy
Redundancy for Cisco TMS Booking Service is supported through the use of a network load balancer (NLB). 
This redundant setup ensures high availability, but does not increase performance.

For prerequisites and setup instructions, see Setting up redundancy for Cisco TMS Booking Service [p.44].

Supported redundancy models
When setting up Cisco TMSXE with redundancy, the following scenarios are supported, in conjunction with a 
load-balanced Cisco TMS setup as described in the "Redundant deployments" chapter of Cisco 
TelePresence Management Suite Installation and Upgrade Guide:

 n If not using Productivity Tools, installing without Booking Service, and setting up two cluster nodes for the 
Cisco TMSXE service, following the instructions in Installing Cisco TMSXE with service clustering [p.39].

 n If using Productivity Tools:
 l setting up two cluster nodes for the Cisco TMSXE service following the instructions in Installing Cisco 

TMSXE with service clustering [p.39].
 l installing Booking Service on both nodes and set up a network load balancer for the Booking Service 

nodes, following the instructions in Setting up redundancy for Cisco TMS Booking Service [p.44].

Redundancy is not supported with small deployments where Cisco TMS and Cisco TMSXE are co-hosted on 
the same server as described in Guidance on large deployments [p.16].

Guidance on large deployments
Cisco TMSXE automatically changes the underlying configuration to better support deployments with large 
numbers of mailboxes added.

With a large deployment, beware of the following:

 n The time it takes to populate the configuration tool systems list, to validate all systems, and to import 
existing meetings from mailboxes added, may be substantial.
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 n As the number of linked systems increases, the time between Exchange mailbox checks increases, which 
means that sometimes Cisco TMSXE sends the booking to Cisco TMS before having information about all 
participants for a meeting. 
 l This behavior will typically be seen in deployments with more than 1700 mailboxes added to Cisco 

TMSXE.
 l This may lead to users receiving multiple confirmations for the same booking, if more than one room is 

booked. 
 l The resulting meeting will function as intended, but the extra notifications and partial bookings may be 

confusing to users.

Best practices for all deployments

Install, upgrade, and add mailboxes during off hours
We strongly recommend upgrades be performed during off hours to minimize down time for users and risk of 
out of sync conditions.

If adding existing mailboxes that already contain bookings to your Cisco TMSXE deployment, you must do 
this off hours, due to the expected impact on Cisco TMS performance during first-time replication.

Provide users with guidance
If deploying the WebEx Scheduling Mailbox or the Cisco TelePresence form, we recommend that users be 
provided with a link to Cisco TelePresence Management Suite Extension for Microsoft Exchange User Guide 
for a simple overview of how the advanced settings work.

Mailbox configurations and the "Private" flag
In order to avoid conflicting settings, all room mailboxes added to Cisco TMSXE must be configured to 
handle booking subjects and privacy settings in the same way. This means that the following settings must 
be applied to all or none of the mailboxes:

 n Delete the subject
 n Add the organizer's name to the subject  
 n Remove the private flag on an accepted meeting

As a best practice, we recommend not relying on the "Private" flag for security. If allowing the flag on 
accepted meetings, make sure to restrict access to opening the resource calendars, or users will still be able 
to see to all meeting information in Outlook.

While the "Private" flag will be respected within the Outlook client, it is not supported by Cisco TMS, and 
meeting subjects will be freely viewable:

 n in Cisco TMS
 n on endpoints that support the "Meetings" calendar

The body of the meeting request and the list of attendees are not sent to Cisco TMS.

If a booking that has a "Private" flag in Exchange has its participants or recurrence pattern modified in Cisco 
TMS, the "Private" flag will be removed when these changes are replicated to Exchange.

See Configuring required settings [p.29] for detailed instructions on the required and supported settings for 
mailboxes.
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Secure communication
We recommend that secure communication be used between the servers. HTTPS is therefore the default 
communication protocol, and the Use HTTP setting in the configuration tool is disabled by default when 
installing the software, both for communicating with Cisco TMS and with Exchange Web Services.

In order for this communication to work as desired, Cisco TMS and Exchange must both present valid 
certificates to Cisco TMSXE.

Certificate requirements

A certificate issued from a trusted CA (Certificate Authority) in the customer network is considered a valid 
certificate if it also:

 n matches the host name of the machine that the certificate is issued for, and the address that the client uses 
to access the server. 

 n has not expired.
 n comes from an issuing CA that has not expired.
 n complies with the company’s internal certificate policy

A company CA must therefore issue certificates for Cisco TMS and Exchange matching the URL used to 
access them, usually the FQDN.

To verify that you have certificates that are valid and working: 

 1. Launch Internet Explorer on the Cisco TMSXE server.
 2. Enter the URL for the Exchange CAS and verify that the URL field turns green.
 3. Enter the URL for the Cisco TMS server and verify that the URL field turns green.

No warnings regarding certificates should be displayed.

Untrusted certificates

Certificates that do not meet the above listed requirements are considered to be untrusted and must not be 
used in a production setting.

If, during initial setup, the certificates encountered for Cisco TMS or Exchange do not validate, the 
configuration tool will prompt the administrator, offering to Allow Untrusted Certificates. This setting 
cannot be reverted and must only be used if installing in a test environment.

Limitations for all deployments
Using delegates for room mailboxes is supported by Cisco TMSXE, but not when using Productivity Tools 
with Outlook.

For an overview of supported scenarios and recommended settings, see Preparing resource mailboxes with 
delegates [p.27].

Booking limitations
If booking a meeting through Outlook, Cisco TMS, or any other booking interface, whose duration is three 
minutes or less, the meeting will not be processed by Cisco TMSXE.
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 n Cascading to additional MCUs when the number of participants exceeds the capacity of the first MCU is 
not supported.
To support such scenarios, set up Cisco TelePresence Conductor as the preferred MCU in Cisco TMS.

 n When a service user is performing all bookings, the booking permissions are the same for all users. 
Individual permissions and restrictions in Cisco TMS are ignored.

 n Meetings in the past cannot be changed or deleted, and you cannot move a meeting from the past to the 
future.

 n If sufficient system licenses are not available at the time of editing an existing booking, the booking will be 
deleted.

 n Yearly recurrence is not supported.

Booking horizon and recurrence

Cisco TMS will decline any meeting request that is not within its booking horizon or that has an unsupported 
recurrence pattern:

 n Series with more than 100 occurrences or with no end date.
 n Meetings including occurrences outside of the Cisco TMS booking window. We strongly recommend 

configuring identical booking windows for Cisco TMS and all integrated resource mailboxes in Exchange.
 n Meetings in the past.

Ongoing meetings

Updating a single meeting that is currently ongoing is possible, but will not always be successful. 

 n Modifying any meeting:                     
 l If the meeting is  using an MCU that does not support WebEx, WebEx may not be added, as the meeting 

would have to be disconnected and re-routed for this to work.
 l Extending the meeting will fail if it creates a booking conflict for any of the participants.

 n Modifying single meetings, including meetings that are part of a series:                     
 l Editing the start time will not work and Cisco TMS will throw an exception.
 l Any other aspects of the meeting can be modified, but if the number of participants exceeds the 

available capacity of the MCU or TelePresence Server, Cisco TMS will throw an exception and the 
participants will not be added.

 n Deleting a  recurrent series while a meeting in the series is ongoing will cause the ongoing meeting to end.
 n Modifying a recurrent series while a meeting in the series is ongoing will turn the ongoing occurrence into a 

single meeting, separate from the series:                     
 l Any occurrences of the modified series that are in conflict with the ongoing meeting, will not be created.
 l Any past occurrences in the series will not be modified.
 l Pending occurrences are assigned new conference IDs.
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System architecture and overview
System overview

Cisco TMSXE communicates with Exchange or Office 365 using Exchange Web Services (EWS).

Using Web Services, Cisco TMSXE passes booking requests to Cisco TelePresence Management Suite 
Extension Booking API (Cisco TMSBA) and receives accept/decline messages.

Depending on the protocol used, Cisco TMSXE uses port 80 (HTTP communication) or port 443 (HTTPS 
communication).

The booking process
The sections below describe how bookings are created in Outlook or Cisco TMS and replicated through 
Cisco TMSXE.

See also Limitations for all deployments [p.18].

Outlook to Cisco TMS
 1. Using Outlook, the organizer creates a meeting request containing one or more video resources and, 

optionally, the WebEx Scheduling Mailbox, then clicks Send.
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Organizers may book from their own calendar or from a resource calendar.
 2. Exchange checks resource calendars for availability and does one of the following:

 l sends an initial confirmation to the organizer that the resources are now booked  and passes requests on 
to Cisco TMSXE.

 l notifies the organizer that none of the resources are available.
In this scenario, Cisco TMSXE is not contacted, and the organizer must re-initiate a booking (step 1).

 l notifies the organizer that one or more resources are unavailable and sends an initial confirmation that 
some of the resources are now booked. The requests for these resources are passed on to Cisco 
TMSXE. 
In this scenario, the organizer must either change the meeting time or find other resources that are 
available at the desired time, and modify the booking using Outlook.

 3. Cisco TMSXE gathers up requests from Exchange and passes them on to Cisco TMS.
 4. Cisco TMS checks system and WebEx availability as relevant.

 l If the conference connection type is requested to be Automatic Connect, One Button to Push, Manual 
Connect, or No Connect, Cisco TMS will also attempt to book routing resources for the conference.

 l If only one video resource and no external participants are requested, no routing attempts will be made, 
regardless of the conference connection type that is requested and stored for the conference.

 l If the     Reservation connection type is requested, the video resources (rooms) are reserved, but no 
routing resources are booked.

 l If the WebEx Scheduling Mailbox was invited to the meeting, Cisco TMS will attempt to include 
WebEx.

 5. On receiving the results of the booking requests, Cisco TMSXE does one of the following:
 l If routing was requested and successful, routing information is sent to the organizer.
 l If one or more resources could not be reserved, or if routing was requested but unsuccessful, Cisco 

TMS will save the meeting as Defective. For more on this scenario, see Defective meetings [p.21].
 l If no routing or WebEx was requested and all resources could be reserved, no notifications are sent.
 l If WebEx was requested and successfully booked, links to join and other WebEx details are included in 

the booking confirmation to organizer. 
 l If WebEx could not be booked, the telepresence meeting booking confirmation will contain a WebEx 

error message stating the problem.

Defective meetings

A Defective conference in Cisco TMS has been booked by an external client that encountered a resource 
conflict or routing problem. 

A defective conference retains all properties of the booking request without setting up routing or consuming 
telepresence resources. Until all issues are resolved, Cisco TMS will not initiate a defective conference or 
send it to endpoints.

 n In the case of a routing issue, all endpoints in the booking will be set to Busy for the scheduled time, 
keeping the reservation while the administrator or user resolves the issue.

 n In the rare case of an endpoint reservation conflict, the endpoints will not be set to Busy for the defective 
booking.

Defective conferences can be corrected by the organizer or the administrator:

 n Users who book conferences that are saved as defective  will be notified by email and can resolve most 
issues by changing their request and rescheduling from their client.

 n Administrators can locate and resolve defective conferences in Cisco TMS by going to Administrative 
Tools > Diagnostics > Conference Diagnostics or Booking > List Conferences. 
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Conferences that are defective because of configuration errors or a permanent lack of routing resources 
must be resolved by an administrator.

When scheduling a series where only some occurrences have a resource conflict or routing issue, Cisco 
TMS will only store the problematic occurrences as defective, leaving the remaining occurrences unaffected.

Master participant

The videoconference master is the participant in the conference who is considered to be the "chair" and the 
one who will be prompted to start a manually connected conference, or extend the meeting if more time is 
needed. Not all endpoints are able to be the videoconference master, as this feature relies on functionality not 
available for all types of endpoints.

When booking from Outlook, Cisco TMS will set the first resource in the Location field as the  master 
participant provided this endpoint has master participant capabilities. If the first resource is not capable of 
being the master, Cisco TMS will choose another endpoint from the participant list.

Cisco TMS to Exchange
 1. Using the Cisco TMS web interface, the organizer books a conference.
 2. Every minute Cisco TMSXE polls Cisco TMS and gets all updates to bookings since the last polling.
 3. Cisco TMSXE creates or updates bookings in Outlook resource calendars, including subject, room 

participants, and a message body that includes information about who booked the meeting in Cisco TMS. 

Not all conference properties are replicated to Exchange when a conference is booked through Cisco TMS:

 n Advanced settings are not replicated.
 n Organizer and all participants are not included in the To: field.
 n When specified through Cisco TMS, the master participant is not reflected in the order of the rooms in the 

Location: field.

Updating Outlook-created bookings using Cisco TMS

When a meeting booked through Outlook is updated using Cisco TMS, resource calendars are updated, but 
the organizer's calendars is not, as         Cisco TMSXE does not have permissions to modify the calendars of 
personal mailboxes.

If rooms are added to a booking from Cisco TMS, the organizer will not be able to remove them using 
Outlook. 

Replication delays
When booking from Outlook, Cisco TMSXE will wait for approximately one minute to collect all the info about 
the meeting before passing the booking to Cisco TMS.

If updating a meeting in Cisco TMS that has also been modified by  an Outlook user, Cisco TMSXE will wait 
to push the change from Cisco TMS :

 n While the change done in Outlook is being pushed to Cisco TMS.
 n Until the item has been left unmodified in Exchange for 4 minutes.
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Communication with WebEx
 n WebEx Productivity Tools with TelePresence communicates directly with WebEx. Therefore, WebEx 

Productivity Tools with TelePresence may be used to book WebEx-only meetings as well as CMR Hybrid 
meetings with both telepresence and WebEx.

 n The WebEx Scheduling Mailbox communicates with WebEx by way of Cisco TMSXE/Cisco 
TMSBA/Cisco TMS. Using this method, whether or not to include WebEx is considered a property of the 
telepresence meeting. 
Booking WebEx-only conferences using this method is possible, but not recommended, as it will trigger 
the use of MCU resources even if no telepresence participants have been booked. Organizers will be 
notified of this in their booking confirmation.
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Preparing to install or upgrade
Some procedures need to be carried out prior to running the Cisco TMSXE installer. The procedures depend 
on whether you are upgrading or performing a new installation, and on which version of Microsoft Exchange 
you are using.

Backing up and upgrading the backend
Before any installation or upgrade we strongly recommend backing up all mailboxes that will be used.

For new installations, we particularly recommend backing up any existing room mailboxes that will be 
repurposed as telepresence room mailboxes prior to installing.

You must also upgrade to the required version of Cisco TMS before initiating any installation or upgrade of 
Cisco TMSXE.

Installing or upgrading Cisco TMS
Before installing or upgrading Cisco TMSXE, install the required version of Cisco TMS, following the 
instructions in Cisco TelePresence Management Suite Installation and Getting Started Guide. For  version 
requirement, see Cisco TMS requirements [p.10]

If upgrading Cisco TMS, you will need to perform the following procedures in the order they are listed:

 1. Back up the Cisco TMS database.
 2. Stop the Cisco TMSXE Windows service if you have an existing installation.
 3. Follow the instructions in Cisco TMS Installation and Upgrade Guide to  upgrade Cisco TMS. 
 4. Follow the instructions in this document to upgrade Cisco TMSXE.

Upgrading Cisco TMS from a version earlier than 14.2

If upgrading from a Cisco TMS version earlier than 14.2 and using Cisco TMSXE for booking from different 
time zones, you may need to upgrade to 14.3.2 and run the Time Zone Update Tool to correct time zone data 
on bookings before upgrading to the version of Cisco TMS required to install this version of Cisco TMSXE.

For detail on how to proceed and who needs to run the time zone update tool, see Cisco TMS Installation and 
Upgrade Guide.

Preparing for a new installation
The option to perform a new installation of Cisco TMSXE will only be available if no previous 3.x version is 
found. (If you already have Cisco TMSXE 3.x installed, running the installer will prompt you to upgrade.)

Perform a clean installation of 4.1 if:

 n You do not have an existing deployment of Cisco TMSXE.
 n You want to set up a test environment/deployment to see how Cisco TMSXE works.

Where an existing deployment exists, we strongly recommend that administrators upgrade.
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Creating a Cisco TMSXE service user in Active Directory
In Exchange Management Console, create a new user mailbox as a service user for Cisco TMSXE with the 
username and password of your choice. The service user will let Cisco TMSXE connect to Exchange and 
Cisco TMS.

Creating a Cisco TMS user for Cisco TMSXE
 1. In Cisco TMS, go to Administrate Tools > User Administrations > Users.
 2. Click New.
 3. Add the details for the previously created Cisco TMSXE service user.
 4. Permissions in Cisco TMS are controlled on a group level. You must do one of the following:

 l Add the account to a group with a smaller subset of permissions, see Setting up minimal required 
permissions [p.25] below.

 l Add the service user to the site administrator group, which has universal access.

For each integrated system, the service user must also have the right to book. This is enabled by default for 
all default user groups in Cisco TMS.

Setting up minimal required permissions

In order for Cisco TMSXE to be able to book endpoints and access booking information from Cisco TMS, you 
must make the service user a site administrator or a member of a group that has a certain set of permissions. 

To view and/or modify the permissions for a Cisco TMS user group:

 1. Go to Administrative Tools > User Administration > Groups.
 2. Hover over the group you want, click the drop-down arrow and select  Set Permissions.
 3. Under Booking, make sure enabled permissions include:

 l Read
 l Update
 l Book on Behalf of
 l Approve Meeting

 4. Click Save if any modifications have been made.

Specifying default conference settings
Default settings used for all bookings regardless of booking interface are specified in Cisco TMS. These 
settings are not transparent to the organizer booking from Outlook; we therefore recommend communicating 
these defaults to users/organizers in your organization.

To modify the default conference settings:

 1. Go to Administrative Tools > Configuration > Conference Settings.
 2. Make sure all default settings are configured as desired. For field-level explanations of the settings, see 

the built-in help (click the question mark in the upper right corner).
 3. If not using WebEx Productivity Tools with TelePresence or the Cisco TelePresence form, pay special 

attention to the field  Default Reservation Type for Scheduled Calls:
 l If you want all scheduled conferences to be automatically routed and connected at the conference start 

time,  set to Automatic Connect.
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 l If you want the calls to be set up, but not automatically launched, opt for One Button to Push or Manual 
Connect.

 l If the setting is Reservation, no routing resources will be scheduled unless the organizer specifies a 
different conference type using the Cisco TelePresence form.

 4. Click Save to apply the changes.

Including WebEx by default

Cisco TMSXE booking is also affected by the WebEx settings in Cisco TMS, located at Administrative 
Tools > Configuration > WebEx Settings.

Note that the field Add WebEx To All Conferences will make Cisco TMS include WebEx in any booking, 
and organizers booking from Outlook may not realize that WebEx is included until receiving the booking 
confirmation.

Per-conference settings

If using WebEx Productivity Tools with TelePresence or the custom Cisco TelePresence booking form, 
organizers will be able to change some of these settings on a per-conference basis. 

For information on rolling out the form to users, see Deploying the Cisco TelePresence advanced settings 
form [p.50]. 

For information on configuring Cisco TMSXE for WebEx Productivity Tools with TelePresence, see Setting 
up WebEx Productivity Tools with TelePresence with Cisco TMSXE [p.48].

For more detail on how booking works for users, see Cisco TelePresence Management Suite Extension for 
Microsoft Exchange User Guide (4.1).

Creating mailboxes for Cisco TMS endpoints in Exchange
Before endpoints can be added to Cisco TMSXE, they must be represented by a room mailbox in Exchange. 

Using PowerShell, Exchange admin center, or Exchange Management Console, create one room mailbox for 
each of your endpoints, such as boardroom@example.com.  

For details on how to create room mailboxes, see:

 n Office 365 and Exchange 2013: Create and Manage Room Mailboxes
 n Exchange 2010: Create a Room or Equipment Mailbox
 n Exchange 2007: How to Create an Equipment Mailbox

To simplify Cisco TMSXE setup, we recommend using the endpoint's Cisco TMS display name as the 
mailbox name (with any spaces removed).

All room mailboxes must then be configured with  the appropriate settings and permissions. See the 
instructions for your version of Exchange in Configuring the room mailboxes [p.27].

Repurposing existing mailboxes

If an endpoint is in a meeting room that already has a room mailbox, the mailbox can be repurposed for Cisco 
TMSXE booking.

Note that any existing bookings in repurposed mailboxes will be replicated to Cisco TMS when  Cisco 
TMSXE starts up. You will get the option to determine whether  email notifications  should be sent to 
organizers if any of these bookings fail. Any bookings in the past will not be replicated.
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Repurposed mailboxes must also be configured following the instructions in Configuring the room mailboxes 
[p.27].

Setting up PowerShell for use with Office 365
Before you can configure mailboxes for use with Cisco TMSXE, you must enable Windows PowerShell to 
work with Office 365, following the below instructions from Microsoft:

 1. Install and Configure Windows PowerShell
 2. Connect Windows PowerShell to the Service

Configuring the room mailboxes
This section describes the necessary steps to configure room mailboxes for use with Cisco TMSXE. 

These steps are required in the following scenarios:

 n A new installation using new or repurposed resource mailboxes
 n One or more new systems being added to your deployment during  upgrade

Administrators upgrading from Cisco TMSXE 3.x do not need to reconfigure their mailboxes, but may still 
want to verify that all resource mailboxes are configured correctly and identically as described below. 

The configuration tool will pop up a warning and errors will be written to the event log for most incorrect 
mailbox configurations. Note that if AutoAccept is not turned on, this will be logged as an INFO message in 
the Cisco TMSXE log.

In addition to the required configurations below, we recommend that room mailboxes be configured to give 
users a minimum of Read access so that free/busy information is available to organizers when booking.

Preparing resource mailboxes with delegates
Using delegates for room mailboxes is supported by Cisco TMSXE, but not when using Productivity Tools 
with Outlook.

Cisco TMSXE has been tested with the following three delegate setups:

 n Email-based: a user or group is defined as a delegate for the resource mailbox, and invites are forwarded to 
the user. The delegate accepts or declines invites from their own mailbox.

 n Calendar-based: a user or group is defined as a delegate for the resource mailbox with Editor permissions, 
and invites are forwarded to the user. The delegate accepts or declines invites directly in the resource 
calendar.

 n Room administrator: a user is defined as a room administrator with a minimum of Editor access to the 
resource mailbox, granting them the permissions to edit existing meetings in the resource calendar, create 
new meetings directly in the calendar, and accept or decline new meeting invites.

Double-booking is not supported with Cisco TMSXE regardless of delegate setup.

Recommended settings for mailboxes with delegates and/or room administrators:

AutomateProcessing          : AutoAccept

AllowConflicts              : False

ForwardRequestsToDelegates  : True
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TentativePendingApproval    : True

ResourceDelegates           : (list of delegate users)

RequestOutOfPolicy          : {}

AllRequestOutOfPolicy       : False

BookInPolicy                : {}

AllBookInPolicy             : False

RequestInPolicy             : {}

AllRequestInPolicy          : True

Setting up impersonation and throttling
Office 365, Exchange 2013, and Exchange 2010

To prevent throttling issues with requests and grant the service user the necessary privileges, you must 
enable impersonation for the service user in Exchange and during Cisco TMSXE configuration.

To set up impersonation:

 1. Use the shell cmdlet New-ManagementRoleAssignment and run the following command:
New-ManagementRoleAssignment –Name:impersonationAssignmentName –
Role:ApplicationImpersonation –User:[ServiceUser]

 2. When configuring Exchange Web Service settings for Cisco TMSXE, make sure to enable Service User 
Impersonation.             

This will allow the service user to impersonate all other users in the organization. To set limitations, use a 
management scope in Exchange; you can create a new one or use an existing scope for this.

For instructions and more detailed information from Microsoft on management scopes and impersonation, 
see:

 n Configuring Exchange Impersonation
 n ApplicationImpersonation Role

Alternative for Exchange 2010

For Exchange 2010, you may opt out of using impersonation by instead granting Full Access Permissions to 
all resource mailboxes for the service user and applying a throttling policy, both of which need to be 
performed at this stage. For instructions, see Appendix 1: Configuring Exchange 2010 without mailbox 
impersonation [p.72].

Exchange 2007

For Exchange 2007, you must set up full access permissions for the service user. Impersonation is not 
supported.

There are two ways to set full access permissions for Exchange 2007; using Exchange Management 
Console or Exchange Management Shell.

In Exchange Management Console:        
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 1. Use the EMC tree to navigate to Recipient Configuration > Mailbox and select the mailbox you want to 
configure.

 2. Right-click the room mailbox and select Manage Full Access Permission....
 3. Add the Cisco TMSXE service user.
 4. Proceed to the Exchange Management Shell instructions below.

If using Exchange Management Shell, enter the following command,  replacing [mailbox] with the name of 
the mailbox you are configuring, @ sign and domain not included:

Add-MailboxPermission [mailbox] -User "[service user]" -AccessRights 
FullAccess. 

Configuring required settings
Make sure that all resource mailboxes are configured identically and in line with the requirements outlined in 
the table below.

Differing settings between mailboxes can cause mismatches between Cisco TMS and Exchange.

Shell parameter Required value Description

AutomateProcessing AutoAccept Sets the mailbox to automatically process invitations

BookingWindowInDays Must be between 
1 and 1080. See 
description for 
recommendation.

Specifies for how long into the future users will be allowed 
to schedule meetings. We strongly recommend that this 
setting match that of Cisco TMS: Administrative Tools > 
Configuration > Conference Settings > Conference 
Create Options >Booking Window (in days).

EnforceSchedulingHorizon True Specifies that recurring meetings that continue outside of 
the booking window will be rejected.

AllowConflicts False Prevents the mailbox from accepting overlapping bookings, 
which is not supported by Cisco TMS.

ConflictPercentageAllowed  These two settings may be set to anything so long as 
AllowConflicts is False.
Any occurrences of a recurrent series that are in conflict 
with existing bookings will then be deleted as exceptions 
by Exchange before the booking is handled by Cisco 
TMSXE and Cisco TMS.

MaximumConflictInstances  

DeleteSubject False 
(recommended) 
or True

We  recommend disabling the option to delete meeting 
subjects. However, if it is a requirement for some room 
mailboxes that this option be enabled, it must the set to True 
for all mailboxes.  

AddOrganizerToSubject False or True  Sets the mailbox to never add the organizer's name to the 
subject of a booking. Optionally, this may be set to true for 
all mailboxes.

 Note that enabling both this setting and the setting to delete 
the subject will cause meeting subjects to be blank in Cisco 
TMS and Cisco TMSXE.
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Shell parameter Required value Description

RemovePrivateProperty True 
(recommended) 
or False

This setting removes the "Private" flags for all meetings 
accepted by the mailbox. The setting does not need to be 
enabled, but must be identical for all mailboxes added to 
Cisco TMSXE. Also note that the "Private" flag is not 
supported by Cisco TMS. For further information, see Best 
practices for all deployments [p.17].

CalendarRepairDisabled
(Set-Mailbox)

True (strongly 
recommended)

Disables the Calendar Repair Assistant (CRA) for the 
mailbox. There is no GUI option to modify this setting. 
The CRA is disabled by default in Exchange 2010 and 
enabled by default in later versions including Office 365.

For more information on the above settings, see:

 n Configure Resource Mailbox Options in Windows PowerShell (Office 365 Help)
 n Configure User and Resource Mailbox Properties (Exchange 2010 Help)
 n Set-MailboxCalendarSettings (Exchange 2007 Help)

To verify that the above settings are active:

 n Use the shell command Get-CalendarProcessing -id [mailbox] | fl
 n To verify that the Calendar Repair Assistant is disabled, use the command Get-Mailbox -id 

[mailbox] | ft CalendarRepairDisabled

 n For Exchange 2007, use the shell command Get-MailboxCalendarSettings - id [mailbox] | 
fl

For more information on the  above console settings, see the Microsoft TechNet article .
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Performing  a new installation
This section describes the required steps to install Cisco TMSXE 4.1 when no previous Cisco TMSXE 
deployment exists.

Before you start
Make sure that:

 n All Prerequisites [p.7] are met.
 n You have considered Best practices for all deployments [p.17].
 n You have completed all steps described in Preparing for a new installation [p.24].
 n You are logged in as a local administrator on the installing server.

If you want to set up a clustered deployment, see Installing Cisco TMSXE with service clustering [p.39].

Running the installer
 1. Check Windows Update and install any critical updates to the .NET framework on the server or servers 

where Cisco TMSXE will be installed. Make sure the .NET version is 4.0 or later. Reboot the server after 
installing if prompted.

 2. Place the installation files on the server. 
 3. Run the Cisco TMSXE installer and accept the End-User License Agreement (EULA) to start the 

installation process.
 4. Select which components to include with your installation:

 l Cisco TMS Booking Service is required if planning to use WebEx Productivity Tools with 
TelePresence.
If enabling this, you will be prompted to modify or confirm the name of the IIS application pool to which 
you want Booking Service installed. See Setting up WebEx Productivity Tools with TelePresence with 
Cisco TMSXE [p.48] for further information.

 l Cisco TMSXE Clustering is required if you want to set up Cisco TMSXE with redundancy. See 
Installing Cisco TMSXE with service clustering [p.39] for further instructions on upgrading to a 
clustered deployment.

 l Performance Monitors can be enabled to allow monitoring Cisco TMSXE performance using standard 
Windows tools.

 5. When you have selected the appropriate components for your deployment, click Next. 
 6. Click Install.
 7. Click Finish when the installation is done to close the installer window and launch the Cisco TMSXE 

configuration tool.

Configuring Cisco TMSXE
Most fields in the configuration tool are required. Clicking Next validates the settings provided for each step 
of the initial configuration. If one or more settings cannot be validated, you will be returned to the previous 
step to allow for corrections. 

This procedure describes each step of the configuration process. For detail on each of the available fields, 
see the Configuration reference [p.35] below.
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 1. Provide your Cisco TMS connection details on the first step, and determine how to authenticate.
If you do not have Cisco TMS set up to use HTTPS, make sure to check Use HTTP.
 If you are using a redundant setup with a network load balancer for Cisco TMS, enter the virtual address of 
the network load balancer here.

 2. For Exchange Web Services, provide all connection details.
 l Enable Autodiscover CAS if this is set up for your environment, or include the address of your 

Exchange Client Access Server (CAS). This will disable the Server Address field. 
 l Enable Resource Mailbox Impersonation if using Exchange 2013 or Exchange 2010 without full 

mailbox access for the service user.
 l You must also determine how to authenticate.
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Click Next to submit your settings. Should the connection fail, you will be prompted with an option to view 
the Exchange Web Services (EWS) log to troubleshoot. 
After viewing the log, close it and click Return to Settings to correct any errors and re-submit.

 3. The Systems configuration step includes  a list of all endpoints in Cisco TMS that are available for 
integration.
Note that room mailboxes must already be available in Exchange, or validation of this step will fail. (See 
Creating mailboxes for Cisco TMS endpoints in Exchange [p.26].) 
To add systems to Cisco TMSXE, you can:
 l Import a list of mailboxes and systems from a .csv file that complies with the file format described in 

System Import and Export [p.37]).
 l Add the systems one by one:                         

 i. Modify the email address pattern to generate the names of your room mailboxes. Use  primary 
SMTP addresses for the room mailboxes, aliases are not supported. Two optional variables are 
available:
 o {{TmsId}} translates to the system's numeric system ID from Cisco TMS.
 o {{DisplayName}} translates to the system's display name in Cisco TMS. Note that any 

spaces in the display name will be removed automatically.
 ii. Select endpoints in the left-hand list and click >> to add them to Cisco TMSXE. Use Ctrl or 

Shift to select multiple endpoints.
 iii. Modify individual email addresses as needed by double-clicking on them after they have been 

added to the right-hand list.
You must also choose whether to notify organizers during first-time replication between new mailboxes 
and systems. If there are conflicts or incompatibilities with Cisco TMS during first-time replication, 
Exchange bookings may be:
 l cancelled due to conflict or incompatibility 
 l downgraded to Reservation with no routing due to conflict or incompatibility. For more information on 

downgraded meetings, see New System Notifications [p.37].
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Click Next to proceed to validation of systems and mailboxes. Note that this may take a while if you have 
a large number of systems; for 250 endpoints, the process could take about 90 seconds.

 4. Under Locations, confirm that you want to use the default folder locations for logs, data, and configuration 
files, or modify them as needed.
If you have configured mailboxes to delete the subject and add the organizer's name to subject, determine 
how to handle the organizer's name, see Never Display Organizer in Cisco TMS Conference Title [p.38]

 5. The next step confirms that the configuration process is completed. Click Finish.             A prompt will ask you 
whether you want to start the Cisco TMSXE service.
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 6. Starting the service will initiate first-time replication between Cisco TMS and Cisco TMSXE. 
 l Start the service immediately only if configuration of all added systems is completed in Cisco TMS, and 

you have a maintenance window, as Cisco TMS performance will be impacted during replication.
 l Decline if you are not ready to start the service at this point, and follow the instructions in Starting and 

stopping the Cisco TMSXE service [p.54] when you are ready to start Cisco TMSXE.

If any validation steps fail during the configuration process, see the section Errors during configuration [p.63].

Configuration reference

Field Description

Cisco TMS  

Server Address This is the IP address or fully qualified domain name (FQDN) for the Cisco TMS server. Do 
not include the protocol (HTTP or HTTPS). A colon and specific port number may be 
included.
If using a secure connection with certificates, you must provide the FQDN.
If you are using a redundant setup with a network load balancer for Cisco TMS, enter the 
virtual address of the network load balancer here.

Use HTTP In communication with Cisco TMS, encryption is used by default. This option disables 
secure communication with Cisco TMS.

Username The username you have created for the Cisco TMSXE service user to log into Cisco TMS. 
For more information, see Creating a Cisco TMSXE service user in Active Directory [p.25].

Password The password for the above user.

Domain The domain that the Cisco TMS server is in.

Exchange Web 
Services

 

CAS Autodisover Specify whether to allow autodiscovery of the Exchange CAS (client access server). This 
feature relies on an autodiscover service being configured on the domain.

Service User Email If using the autodiscover feature, provide the full email address of the Cisco TMSXE service 
user. See Creating a Cisco TMSXE service user in Active Directory [p.25].

Server Address If not using the Autodiscover feature, provide the  address of the Exchange Client Access 
Server (CAS), entered as a fully qualified domain name (FQDN). 
 n Do not include the protocol (HTTP or HTTPS). 
 n A colon and specific port number may be included.

Use HTTP In communication with Exchange Web Services, encryption is used by default. This option 
disables secure communication with EWS.

Table 5: Configuration tool field reference
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Field Description

Sender Email 
Address

The email address used as the From: address of all notifications to organizers booking 
through Cisco TMSXE. Leave blank to use the Cisco TMSXE service user email address. 
If you want organizers to receive notifications from an address they can reply to,  a support 
email address or similar can be added here. Note that you must grant the service user 
Send as permissions for this address, see:       
 n Office 365: Manage Permissions for Recipients
 n Exchange 2013: Add-ADPermission
 n Exchange 2010: Manage Send As Permissions for a Mailbox
 n Exchange 2007: How to Grant the Send As Permission for a Mailbox

WebEx Scheduling 
Email

The address of the WebEx Scheduling Mailbox. For more information, see Setting up the 
WebEx Scheduling Mailbox [p.46].

Resource Mailbox 
Impersonation

Specify whether to make the Cisco TMSXE service user impersonate room mailboxes 
when contacting Exchange, to avoid throttling issues due to a high number of calls from 
one account. This setting is required for Office 365 and recommended for Exchange 2013 
and 2010.
Note:
 n On Exchange 2010, you can opt to apply a throttling policy instead, see Appendix 1: 

Configuring Exchange 2010 without mailbox impersonation [p.72].
 n On Exchange 2007, impersonation is not supported. You must give the service user full 

access permissions. See Setting up impersonation and throttling [p.28].

Username and 
password 
authentication

Authenticate with the username and password of the service user created in 
Exchange/Active Directory, see Creating a Cisco TMSXE service user in Active Directory 
[p.25].
 n Username—The Cisco TMSXE service user in Exchange/Active Directory.
 n Password—The password for the above user.
 n Domain—The domain the Exchange server is in.

Client certificate 
authentication

Authenticate with a client certificate and password.
 n Certificate—Browse for the client certificate to use for authentication with Exchange. For 

prerequisites for using this authentication mode, see Certificate authentication [p.12].
 n Password—The password for the above certificate.

Systems  

Email Pattern  n When building the email pattern, the optional variables {{TmsId}} and 
{{DisplayName}} translate to the endpoint's TMS System ID and Display Name in 
Cisco TMS respectively. Any whitespaces in the display name will be removed 
automatically.

 n To simplify setup when there are many systems to add, using the Cisco TMS display 
name as the mailbox name is therefore recommended. For instructions, see Creating 
mailboxes for Cisco TMS endpoints in Exchange [p.26].

 n The email domain defaults to your domain.
 n If the mailbox names in your organization cannot be represented by such a pattern, 

each email address can be edited manually after they have been added to the right-
hand list on this configuration tab.

Table 5: Configuration tool field reference (continued)
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Field Description

System Import and 
Export

Instead of adding mailboxes one by one to the list, you may import a comma-separated list 
of mailboxes and the Cisco TMS systems you want to associate them with.
The list must be stored as a .csv file, and the valid format is the following, where the 
header row and System Name field are optional, and the second row contains example 
values:

TMS ID, System Name,Email
 42,Meeting Room 1,meetingroom1@example.com

You can also export a list of already-added systems in the same format.

New System 
Notifications

When adding existing room mailboxes to Cisco TMSXE, their calendars may already 
contain future bookings. On addition, Cisco TMSXE will perform a two-way 
synchronization, attempting to book all existing meetings from the Exchange mailbox in 
Cisco TMS and replicating any existing bookings for the associated system in Cisco TMS 
to Exchange. 
When a booking is incompatible during synchronization with Cisco TMS, Exchange 
bookings will be declined and Cisco TMS bookings preferred where they exist. You can 
opt to:
 n Send decline to organizer—the meeting owner receives notification that the meeting has 

been declined by Cisco TMS.
 n Delete and log—the meeting is silently declined, but the administrator can find the 

declined meetings in the Cisco TMSXE log.

In the event of routing problems or certain other issues with the synchronized meeting, 
Cisco TMSXE can "downgrade" a meeting to the Reservation type, where no automatic 
call setup is performed and routing resources are not reserved. 
Similar to declines, you can select whether to notify the meeting organizer or silently 
downgrade the meeting and log it.
For more information about downgrading of meetings, see Messages from Cisco TMSXE 
[p.57].

Table 5: Configuration tool field reference (continued)
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Field Description

Advanced Settings  

Data Files Cisco TMSXE stores files at these default locations on the drive where Cisco TMSXE is 
installed (usually C:):
 n \ProgramData\Cisco\TMSXE\Storage for data files
 n \ProgramData\Cisco\TMSXE\Config for configuration files
 n \ProgramData\Cisco\TMSXE\Logs for error and event logs

The ProgramData Windows folder is hidden by default and located on the drive where 
Cisco TMSXE is installed.
When configuring a Cisco TMSXE cluster, there will be four fields:
 n Shared Data Files
 n Shared Configuration 
 n Local Configuration 
 n Local Logs

Shared Data Files and Shared Configuration must be changed to point to network shares 
where all nodes have read/write access. 
Local Configuration contains username and password data that can only be decrypted on 
the local server and must not be shared between nodes.
Local Logs may point to a network share, but each node must have a separate folder for 
logs.

Configuration

Logs

Never Display 
Organizer in Cisco 
TMS Conference 
Title

When a resource mailbox is set to both Delete Subject and Add Organizer to Subject, 
enabling this setting keeps the subject for the meeting entirely blank.

Table 5: Configuration tool field reference (continued)
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Setting up a redundant deployment
Cisco TMSXE clustering provides active/passive redundancy for the Cisco TMSXE service. To achieve 
redundancy for Cisco TMS Booking Service, you must also deploy a network load balancer.

This section provides instructions for setting up redundance for both Cisco TMSXE and Cisco TMS Booking 
Service. For an overview of supported scenarios and how redundancy works, see Redundant deployments 
[p.16].

Limitations
 n Redundancy is not supported with Exchange 2007
 n Redundancy is not supported for small deployments where Cisco TMSXE resides on the Cisco TMS 

server.
 n Load-balancing of Cisco TMS Booking Service is only supported in combination with Cisco TMSXE 

clustering and a redundant Cisco TMS deployment.

Installing Cisco TMSXE with service clustering
During installation or upgrade, you can choose whether to implement active/passive redundancy for Cisco 
TMSXE by enabling cluster support.

Before you start
Ensure that both servers meet the Cisco TMSXE server software requirements [p.9] and are ready for 
installation. 

You can upgrade from an existing, non-clustered installation to a clustered one, provided the following:

 n The first node is running Cisco TMSXE 3.x.
 n The second node does not have any Cisco TMSXE application or data files on it prior to installation. For 

instructions on complete removal of Cisco TMSXE from a server, see Uninstalling Cisco TMSXE 4.1 
[p.60].

Setting up a network share for cluster configuration
Before installing Cisco TMSXE with clustering, you must make a network share available that has read and 
write access for both nodes and the user that will configure Cisco TMSXE.

 n The share and both nodes must be members of an Active Directory domain where sharing with machine 
accounts is possible.

 n The accounts must have file share permissions and file permissions to the folder.
 n You must not locate the network share on either of the nodes, or use a mapped drive letter.
 n We recommend that you only make the network share  accessible to the machine accounts of both nodes 

and the administrator performing the installation.

Note that while you may opt to place the log folder on a network share, each Cisco TMSXE node must have a 
separate log location. The log level is part of the shared configuration.
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Example setup

In this example on a Windows Server 2012 installation, the configuration will be stored on the server 
filestore.example.com, while the nodes where Cisco TMSXE will be installed are 
tmsxe1.example.com and tmsxe2.example.com. The administrator performing the installation is a 
domain user named tmsxeadmin.

Creating a folder and editing file share permissions:

 1. On filestore.example.com, create a folder tmsxeconfig.
 2. To enable folder sharing, go to Properties > Sharing > Advanced Sharing.
 3. Check Share this Folder.
 4. Click Permissions.
 5. Click Add, then Object Types, and make sure that Computers and Users are checked.
 6. In the entry field for object names, enter tmsxe1, tmsxe2, and tmsxeadmin.
 7. Click OK.
 8. Select tmsxe1 and set Full Control to Allow. Repeat for the remaining two accounts.
 9. Click OK, then click OK again to exit the permissions for the file share.

Editing file permissions:

 1. In Properties > Security, click Edit. 
 2. Click Add, then Object Types, and make sure that Computers and Users are checked.
 3. In the entry field for object names, enter tmsxe1, tmsxe2, and tmsxeadmin.
 4. Click OK.
 5. Select tmsxe1 and set Full Control to Allow. Repeat for the remaining two accounts.
 6. Click OK, then click Close to save the new settings.

Performing the installations
For new installations and upgrades on both nodes, follow the instructions for running the installer, making 
sure to enable clustering.
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Configuring the first node
When the configuration tool opens:
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 1. If this is a new installation, specify on the first step that this is the first node in the cluster.
This configuration step will not be available if you are upgrading an existing installation.

 2. Follow the instructions for configuring a regular installation as described in Configuring Cisco TMSXE 
[p.31], making sure to add a minimum of one system on the Systems tab. 

 3. On the Advanced Settings tab, change the folder locations for shared data and configuration files to be on 
a network share to which both nodes have read/write access, for example:    
\\server\share\Config

 l For a new installation, these location fields will be called Shared Data Files and Shared 
Configuration.

 l For an upgrade from a non-clustered deployment, the fields are called Data Files and Configuration.
 l Local Configuration contains usernames and passwords that can only be decrypted on the local 

server and must not be shared.
 4. Click Save.

Configuring the second node
Before configuring the second node, stop Cisco TMSXE service on first node. Perform the following steps 
when the configuration tool opens:

 1. On the first tab, specify that the first node has already been configured.
 2. Provide the necessary Exchange connection details, which must be exactly the same as for the first node.

Cisco TMSXE will use this detail to identify the primary node, and all configuration data that can be 
shared, will be imported and validated.

 3. An overview of the imported data is displayed.      
 l Red marks will be shown if some or all of the data could not be validated, with guidance on addressing 

the issues:       
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 i. Resolve any issues on the first node or with access to network shares.
 ii. On this node, go back to the previous step, and re-validate the import.

 l When green checkmarks are shown, click Next.
 4. Enter authentication details for Cisco TMS and Exchange. 

These need to be stored per server and cannot be imported.
 5. Click Next to validate all settings.
 6. Click Next to save the settings.
 7. Click Finish.

Verifying the cluster setup
Using remote desktop, connect to one or both of the nodes and do one of the following: 

 n Start the configuration tool, and the first screen will include information about the current state of the 
cluster. 

 n Check TMSXE-log.txt, which includes information about which node is active and the state of the node 
you are connected to.

To test that failover is working:

 1. Stop the Cisco TMSXE service on the active node.
 2. Verify using the log or configuration tool on the second node that it has been promoted to active.

Changing the configuration for an existing cluster
You can add and remove systems from the configuration tool while the Cisco TMS service is running in 
clustered mode. You cannot, however, replace a system while the service is running.

To make any other configuration changes, including replacing an existing system, you must stop the Cisco 
TMSXE service on both nodes before launching the configuration tool, and make the changes on both nodes 
before restarting the service. We recommend stopping the service on the passive node first.

Changing credentials

We strongly recommend against changing the Exchange service user for a clustered deployment, as the 
cluster information is stored on the service user in Exchange, and adding a new service user to Cisco 
TMSXE will create a new cluster.

To change the password or the certificate for an existing user, this must always be done for both nodes in 
parallel. 

Changing the Exchange or Cisco TMS credentials

To avoid one node encountering a password error, we recommend turning off both nodes before making the 
change:

 1. Turn off the service on the passive node.
 2. Turn off the service on the active node.
 3. Change the password for the service user in Active Directory.
 4. Add new password using the configuration tool on the first node.
 5. Add new password using the configuration tool on the second node.
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 6. Start service on first node.
 7. Start service on second node.

Changing the client certificate

To update the client certificate to a new one that authenticates the same service user, typically because the 
old certificate is due to expire:

 1. Turn off the service on the passive node.
 2. Turn off the service on the second node.
 3. Change the client certificate using the configuration tool on this node.
 4. Change the client certificate using the configuration tool on the second node.
 5. Start the service on this node.
 6. Start the service on the second node.

Setting up redundancy for Cisco TMS Booking Service
Cisco TMS Booking Service can be set up with active/active redundancy using a network load balancer 
(NLB) to ensure high availability.

Prerequisites
 n The NLB must support Windows authentication, as the probe URL is authenticated.

We recommend using F5 BIG-IP version 11.4.1, which has been tested and is known to work with Cisco 
TMSXE.

 n The Cisco TMSXE servers must use a certificate where the Common Name (CN) is a DNS entry pointing 
to the  virtual IP of the network load balancer.

Before you start
 n Set up identical installations of Cisco TMSXE, including Booking Service, on both nodes following the 

instructions in Installing Cisco TMSXE with service clustering [p.39].
 n Note that as for the Cisco TMS service, logs for the Booking Service nodes are separate, but the log level 

is a part of the shared configuration.

Deploying the load balancer
 1. Set the NLB to probe this URL on both nodes every 15 

seconds: /TMSService/Booking.svc/Status/Health
 2. For performance reasons, you must set up the load balancer to have a sticky connection to one of the 

nodes. 
When the primary node cannot be reached, the load balancer will switch to the secondary node.

 3. Create a DNS record for the virtual IP of the NLB.
 4. Add this NLB hostname to WebEx as the Cisco TMSXE Host Address, see Setting up communication 

between WebEx and Cisco TMSXE [p.49].

Note that when NLB is configured to probe the booking service, you must use HTTPS connection on port 
8443. 

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 44 of 82

Setting up a redundant deployment



Probe responses

Cisco TMS Booking Service checks the connection to Cisco TMS every 15 seconds.

When regularly probing each Booking Service node as described above:

 n HTTP 200 OK will be returned if the connections to AD and Cisco TMS are alive, and the location of the 
configuration files is available.

 n HTTP 503 Service Unavailable will be returned with one or more messages detailing the error if there is a 
problem with any of the above connections.
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Configuring additional features
When Cisco TMSXE is installed and configured, users will be able to book telepresence meetings from 
Outlook by adding telepresence-enabled rooms as locations for their meetings. The meetings will use default 
settings from Cisco TMS.

If you want users to be able to change certain settings on a per-meeting basis, include WebEx in their 
meeting, or schedule call-in and call-out participants, you must make additional features available to your 
users. The available options are described in this chapter.

Setting up the WebEx Scheduling Mailbox
For deployments where Cisco Collaboration Meeting Rooms Hybrid is available, the WebEx Scheduling 
Mailbox is a simple way for meeting organizers to include a WebEx conference with default settings in their 
telepresence meeting.

The administrator creates a special user or resource/room mailbox, as described below, allowing users to 
include WebEx in their telepresence meeting by adding this mailbox to their Outlook meeting request.

Note that:

 n this solution is intended for the creation of CMR Hybrid meetings with both WebEx and telepresence. 
 n the mailbox must not be used to schedule WebEx-only meetings, as telepresence infrastructure resources 

will be booked and used during the meeting even if no telepresence rooms or call-in telepresence 
participants are included.

Before you start
Make sure that all Cisco Collaboration Meeting Rooms Hybrid requirements [p.11] are met.

Creating and configuring the mailbox
Create and configure the mailbox using either Exchange Admin Center, Exchange Management Console, or 
Exchange Management Shell:

 1. Create a new resource mailbox called "WebEx". For instructions, see:
 l Office 365 and Exchange 2013: Create and Manage Room Mailboxes
 l Exchange 2010: Create a Room or Equipment Mailbox
 l Exchange 2007: How to Create an Equipment Mailbox

 2. If using Exchange 2007 or Exchange 2010 without mailbox impersonation, you must give the  Cisco 
TMSXE service user account Full Mailbox Access to this mailbox. For instructions, see:
 l Exchange 2010: Allow Mailbox Access  
 l Exchange 2007: How to Allow Mailbox Access

 3. Modify the mailbox properties:
 a. Turn off the Calendar Attendant for the mailbox. For instructions, see: 

 o Office 365 and Exchange 2013: Set-CalendarProcessing
 o Exchange 2010: Configure User and Resource Mailbox Properties
 o Exchange 2007: How to Disable the Auto-Processing of Meeting Messages

 b. Make sure new requests are not automatically marked as tentative by disabling 
AddNewRequestsTentatively (also known as Mark new meeting requests as Tentative) for the 
mailbox.
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 c. Set ForwardRequestsToDelegates to False.
 d. For Office 365, Exchange 2013, and Exchange 2010: Set CalendarRepairDisabled to True.

Note that we previously recommended that the WebEx Scheduling Mailbox be created as a user mailbox. 
Starting with Exchange 2013, user mailboxes are no longer compatible with the required settings for the 
WebEx Scheduling Mailbox. 

A user mailbox with the above settings will still work with Exchange 2010 and Exchange 2007, but not with 
Exchange 2013 and Office 365.

Additional recommendations

We also recommend the following configurations:

 n Using Exchange Management Console Mail Flow Settings or Exchange Management Shell, stricten the 
message delivery restrictions as needed.
For example, require senders to be authenticated, only allow from people in a specific group, or similar.
For instructions, see:
 l Office 365 and Exchange 2013: Configure Message Delivery Restrictions for a Mailbox  
 l Exchange 2010: Configure Message Delivery Restrictions
 l Exchange 2007: How to Configure Message Delivery Restrictions

 n Using AD Users and computers or Powershell, set the Active Directory user account to disabled.
See the TechNet article Disable or Enable a User Account for instructions.

Adding the mailbox to Cisco TMSXE
You can add the mailbox to the Cisco TMSXE configuration wizard immediately after installation or upgrade.

If adding the mailbox at a later stage:

 1. Open the configuration tool and go to the Exchange Web Services tab.
 2. In the WebEx Scheduling Email field, fill in the email address of your newly created WebEx Scheduling 

Mailbox.
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 3. Click Save.

Setting up WebEx Productivity Tools with TelePresence with 
Cisco TMSXE
WebEx Productivity Tools with TelePresence adds a special panel to Outlook for Windows that allows users 
to synchronously book and configure:

 n CMR Hybrid meetings that include both WebEx and telepresence.
 n WebEx-only meetings.
 n Telepresence-only meetings.

The panel  provides access to simple and advanced settings for both WebEx and telepresence, including the 
option of adding call-in and call-out telepresence participants, and allowing WebEx participants to join the 
meeting ahead of start time.

Note that all organizers must be set up with a WebEx user for Productivity Tools to work, even when booking 
telepresence-only meetings.

Detailed instructions on configuration and deployment of  WebEx Productivity Tools with TelePresence can 
be found in  Cisco WebEx Site Administration User's Guide, which is available as webhelp and PDF from 
your WebEx site.
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Installing and configuring Cisco TMS Booking Service 
To allow WebEx Productivity Tools with TelePresence to communicate with Cisco TMSXE you must have 
Booking Service installed.

You can set up Booking Service with load balancing.

 n For guidance on supported scenarios, see Redundant deployments [p.16].
 n For setup instructions, see Setting up redundancy for Cisco TMS Booking Service [p.44].

If you did not include the Cisco TMS Booking Service during initial installation, follow these instructions to 
add it to your deployment:

 1. On the Cisco TMSXE server, go to Control Panel.
 2. Select Programs and Features.
 3. Right-click on "Cisco TMSXE" and select Change.

This starts the installer and allows you to change your installation.
 4. Follow all instructions provided by the installer and opt to include Cisco TMS Booking Service.

When the installation is complete, a virtual directory called TMSService will be available under Default 
Web Site in IIS .

Note that installing the Booking Service forces a restart of IIS. This will affect Cisco TMS if the two are co-
located, although this is only recommended for small deployments, see Best practices for all deployments 
[p.17].

Configuring IIS for HTTPS

For Booking Service to work, you must enable HTTPS for Default Web Site in IIS on the server where Cisco 
TMSXE and Booking Service are both installed. In a redundant deployment, this must be done on both 
nodes.

If IIS is not present on the server prior to installation, it will be automatically installed with Booking Service. 
You must then configure HTTPS for Default Web Site after installation.

For general guidance, see for example the IIS article How to Set Up SSL on IIS 7.

For WebEx Productivity Tools with TelePresence to operate, you must also:

 1. Open IIS Manager.
 2. Go to IIS > SSL Settings.
 3. Set Client certificates to Ignore.

Setting up communication between WebEx and Cisco TMSXE

 1. On your WebEx site, go to Manage Site > Site Settings > OneTouch TelePresence Options.
 2. In the Cisco TMSXE Host Address field, enter the full address of the Booking Service by including the 

hostname of the server in the following address: 
https://<hostname>/TMSService/Booking.svc.

 3. Save the update.

For overall instructions on setting up Cisco Collaboration Meeting Rooms Hybrid, see Cisco WebEx Enabled 
TelePresence Configuration Guide.
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Deploying the Cisco TelePresence advanced settings form
The Cisco TMSXE deliverable includes a custom form that  adds functionality to Outlook clients when 
creating or modifying videoconference meetings. 

Available settings include specifying conference parameters and adding external participants. A detailed 
description of the available functionality can be found in Cisco TMSXE User Guide (4.1).

The deployment and use of this form is optional. The form can also be added to an installation at any time in 
the future.

The form is an alternative to WebEx Productivity Tools with TelePresence for users that do not have WebEx, 
but need access to advanced telepresence settings.

The form does not contain an option to include WebEx in the meeting, but it may be used in combination with 
Setting up the WebEx Scheduling Mailbox [p.46].

Limitations
Note that:

 n custom forms only work with Outlook for Windows.
 n the Organizational Forms Library is not supported in Office 365, which means the form can only be 

published locally (see below).
 n editing the form is not supported.

Best practice
As a best practice, we recommend that the form be placed in the Organizational Forms Library, which makes 
for simple distribution to all users and will automate any future updates to the form. You must either use an 
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existing Organizational Forms Library on your Exchange server, or create a new one before the custom form 
can be imported into the library. 

Deployment with the Organizational Forms Library requires the following three steps:

 1. Creating the Organizational Forms Library [p.51]
 2. Publishing the Cisco TelePresence form [p.51]
 3. Configuring clients to use the form [p.52]

Administrators who are upgrading and that are already using the Cisco TelePresence form,  need only refer to 
step 2.

The form can also be loaded manually per Outlook client, without using the Organizational Forms Library. In 
this case, step 1 can be omitted, but the form must be published locally before it can be used. Follow the 
instructions in Publishing the Cisco TelePresence form [p.51].

Creating the Organizational Forms Library
You Exchange environment may lack the required infrastructure to support the Organizational Forms Library. 
The  necessary steps required for publishing the Cisco TelePresence form will therefore vary based on 
whether Public Folders are already present.

Setting up an Organizational Forms Library

See available documentation regarding Public Folders and Organization Forms Libraries in Exchange: 

 n Exchange 2013: Create an Organizational Forms Library in Exchange 2013
 n Exchange 2010: Create an Organizational Forms Library
 n Exchange 2007: How to Create an Organizational Forms Library in Exchange 2007

Publishing the Cisco TelePresence form
Before the form can be used, it must be published using an Outlook client. If using the Organizational Forms 
Library, this library must be in place before following the steps below, see Creating the Organizational Forms 
Library [p.51].

Acquiring the form

On the server where Cisco TMSXE was installed:

 1. Locate the VideoConference-*.oft in the Cisco TMSXE .zip archive. 
 2. Copy the file   to a client computer with Outlook installed.

Publishing from Outlook 2013 or 2010

 1. Log into Outlook  and make sure you do not have a booking request open. If publishing to the 
Organizational Forms Library, you must log in as the user that has Owner permissions for the forms library.

 2. On the ribbon, go to File > Options > Customize Ribbon.
 3. Check Developer and click OK.
 4. On the ribbon, go to Developer > Design a Form....            
 5. In the dialog that opens, change the Look In dropdown menu to User templates in File System.
 6. Click Browse.
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 7. Locate the .oft file on the computer, and open it. 
 8. From the Publish dropdown button, select Publish Form As....   
 9. In the dialog that opens, change the Look In dropdown menu to one of the following:    

 l Organizational Forms Library if you want to make the form available to several users.
 l Personal Forms Library if you are publishing only for use with the current user account.

 10. Enter names in the two fields exactly as described below (case sensitive):         
 l Display name: Meeting
 l Form name: VideoConference

 11. Click Publish when complete.

The form will now be published and available for users to choose as their appointment form, see Configuring 
clients to use the form [p.52].

Publishing from Outlook 2007

 1. Log into Outlook  and make sure you do not have a booking request open.If publishing to the Organizational 
Forms Library, you must log in as the user that has Owner permissions for the forms library.

 2. In the menu go to Tools > Forms… > Design a Form…
 3. Change the Look In dropdown menu to User templates in File System.
 4. Click Browse.
 5. Locate the .oft file on the computer, and open it. 
 6. From the Publish dropdown button, select Publish Form As....   
 7. In the dialog that opens, change the Look In dropdown menu to one of the following:    

 l Organizational Forms Library if you want to make the form available to several users.
 l Personal Forms Library if you are publishing only for use with the current user account.

 8. Enter names in the two fields  as described below:         
 l Display name: Meeting
 l Form name: VideoConference

 9. Click Publish when complete.

The form will now be published and available for users to choose as their appointment form, see Configuring 
clients to use the form [p.52].

Configuring clients to use the form
Publishing the form makes it available to users, but does not force their Outlook client to use the form. 
Configuring Outlook to use the form is a one-time client configuration that can be done by each user, or by 
making changes to the Microsoft Windows Registry. Registry changes can be done automatically using 
methods such as Group Policy.

Manually configuring clients to use the form

To configure the form per computer, each user must complete the following steps:

 1. Open the Outlook client and go to the calendar.
 2. In the left-side folder view, right-click the Calendar entry and select Properties.
 3. Outlook 2010 only: Click the Folder tab, then click Calendar Properties.
 4. The Calendar Properties window will open with the General tab selected.
 5. From the When posting to this folder, use dropdown list, select Forms.
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 6. A dialog will open. In the Look In drop-down menu, make sure to select the library where the form was 
published, either Organizational Forms Library or Personal Forms Library.

 7. An entry named Meeting will be displayed. Select it and click Open.
 8. You will be returned to the Calendar Properties page. Click OK to save your changes

The client will now use the Cisco TelePresence form for all Calendar actions and have the Cisco 
TelePresence tab available when creating new booking requests.
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Maintaining Cisco TMSXE
Starting and stopping the Cisco TMSXE service
Cisco TMSXE is a service that can be started and stopped from the Windows Server Services snap-in.

The Cisco TMSXE configuration tool will stop the service for you when you need to make configuration 
changes beyond adding and removing endpoints, and prompt you to restart the service when you close the 
tool. If you decline these prompts, you must manually start and stop the service. 

Note that in a clustered deployment, you must stop the service on both nodes to enable full configuration, and 
restart both services once configuration changes are complete.

The configuration tool must be closed and initial configuration must be completed before the service can 
start. 

 1. Open Server Manager.
 2. Go to Configuration > Services > Cisco TMSXE.
 3. Right-click Cisco TMSXE and select Start or Stop.

If the service fails to start, the error will be logged. See Troubleshooting [p.61] for more information.

If any booking or modification requests are made while the service is halted, they will be queued and then 
processed as soon as the service is restarted.

Launching the configuration tool
To launch the tool, do one of the following:

 n Go to the Windows Server Start menu or Start screen: Start > All Programs > Cisco > Cisco 
TMSXE Configuration

 n Run it as administrator from the command prompt. The configuration tool is located in the Cisco TMSXE 
installation folder, by default the program path is C:\Program 
Files\Cisco\TMSXE\ConfigurationApp.exe.

On tool startup, you will be asked whether you want to to stop the Cisco TMSXE service. You can leave the 
service running if adding a new system or removing an existing one. For full configuration options, you must 
stop the service.

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 54 of 82

Maintaining Cisco TMSXE



If you stopped the Cisco TMSXE service when starting the tool, you will be prompted to restart it when you 
exit.

Switches
The tool supports the following switches:

 n -help displays a short help file.
 n -wizard runs the configuration tool in setup wizard mode, intended to make sure all required fields are 

completed at initial setup. If no  configuration is detected, a prompt will ask the user whether to migrate 
settings from an existing deployment.

For regular administrative tasks, run the configuration tool without any command-line arguments. 

Adding, removing, and replacing endpoints
This section describes how to add, remove, and replace endpoints and mailboxes to your deployment when 
Cisco TMSXE is in operation.

Note that while systems can be added and removed without stopping the Cisco TMSXE service, replacing 
an endpoint or mailbox, or re-adding one that has previously been removed, requires stopping the service and 
enabling full configuration mode in the configuration tool.

Adding endpoints
If adding existing mailboxes that already contain bookings to your Cisco TMSXE deployment, you must do 
this off hours, due to the expected impact on Cisco TMS performance during first-time replication.

To add one or more endpoints to your deployment, follow the steps below. Note that the procedure is identical 
for clustered and non-clustered Cisco TMSXE:
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 1. Ensure that the endpoints are already added to Cisco TMS and that sufficient system licenses for Cisco 
TMSXE are available, if using a per-system option key.

 2. Create or repurpose room mailboxes for the endpoints, following the instructions in Creating mailboxes for 
Cisco TMS endpoints in Exchange [p.26].

 3. Ensure that the mailboxes are correctly configured, following the instructions in Configuring the room 
mailboxes [p.27].

 4. Start the configuration tool by going to Start > All Programs > Cisco > Cisco TMSXE Configuration.
 5. Select Add or remove systems while Cisco TMSXE is running and click Next.
 6. There are two ways to add endpoints:

 l Manually add each endpoint:
 i. Modify the email address pattern to generate the names of your room mailboxes. Use  primary 

SMTP addresses for the room mailboxes, aliases are not supported. Two optional variables are 
available:
 o {{TmsId}} translates to the system's numeric system ID from Cisco TMS.
 o {{DisplayName}} translates to the system's display name in Cisco TMS. Note that any 

spaces in the display name will be removed automatically.
 ii. Select endpoints in the left-hand list and click >> to add them to Cisco TMSXE. Use Ctrl or 

Shift to select multiple endpoints.
 iii. Modify individual email addresses as needed by double-clicking on them after they have been 

added to the right-hand list.
 l Click Import Systems from CSV file to import a comma-separated list of endpoints with email 

addresses and Cisco TMS system IDs.
The list must be stored as a .csv file, and the valid format is the following, where the header row and 
System Name field are optional, and the second row contains example values:

TMS ID, System Name,Email
 42,Meeting Room 1,meetingroom1@example.com

 7. Click Save. 
The added mailboxes are validated. Note that this may take a while if you have added a large number of 
systems; for 250 endpoints, the process could take about 90 seconds.

 8. Click Exit.
The changes will be applied after a minimum of 10 minutes. In some cases it may take up to 30 minutes.

Removing endpoints
The procedure is identical for clustered and non-clustered environments:

 1. Start the configuration tool by going to Start > All Programs > Cisco > Cisco TMSXE Configuration.
 2. Select Add or remove systems while Cisco TMSXE is running and click Next.
 3. In the list of systems added to Cisco TMSXE, locate the system(s) you want. Use Shift or Ctrl to 

select multiple systems. Click <<.
 4. When done, click Save to validate the remaining systems.
 5. Click Exit to close the configuration tool.     

The changes will be applied after a minimum of 10 minutes. In some cases it may take up to 30 minutes.

The above procedure will remove the endpoint and its mailbox from Cisco TMSXE, while the mailbox and 
system remain bookable independently in Cisco TMS and Exchange.
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Disabling the Exchange Integration Option license flag

If using the Exchange Integration Option key, you must also disable a setting in Cisco TMS to prevent the 
removed endpoint from using a  license.

Update the system as follows:

 1. In Cisco TMS, go to Systems > Navigator.
 2. Select the system you want.
 3. Click the Settings tab.
 4. In the            TMS Scheduling Settings pane, you will find Allow Remote Bookings.

If the setting is Yes, the system is currently using an Exchange Integration Option license.
 5. To disable the setting:

 a. Click Edit Settings.
 b. Uncheck Allow Remote Bookings.
 c. Click Save.

Removing endpoints from a deployment

To remove endpoints completely from your deployment, you must also:

 n Delete the mailbox from Exchange.
 n Delete the system from Cisco TMS.

Replacing an endpoint
You must stop the Cisco TMSXE service and enable full configuration mode in the configuration tool if you 
need to:

 n associate an endpoint already in Cisco TMSXE with a new mailbox.
 n associate a mailbox already in Cisco TMSXE with a different endpoint.
 n re-add an endpoint that has previously been removed, for example for maintenance.

In a clustered deployment, make sure to:

 n stop the service on both nodes, starting with the passive node, before making any configuration changes.
 n complete all changes before restarting both services.

Messages from Cisco TMSXE
When organizers book videoconferences using Outlook, they will receive  messages both from Exchange and 
Cisco TMSXE. 

Cisco TMSXE will send messages when:

 n Routing is successfully set up for a conference with one of the following settings:
 l Automatic Connect
 l Manual Connect
 l No Connect
 l One Button to Push

 n A requested conference routing is unsuccessful, and the conference is booked as Reservation instead (see 
below).
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 n A conference with the setting      Reservation was successfully booked, but one or more resources were not 
available.

No notification is sent from Cisco TMSXE in the following cases:

 n All resources are available for a conference successfully booked with the Reservation setting.
 n A meeting is deleted by the organizer.

Also note that Cisco TMSXE never sends notifications about bookings or updates made in Cisco TMS. 
Notifications will be sent by Cisco TMS depending on system settings.

For guidance on identifying and correcting problematic or failed bookings in Cisco TMS, see Identifying and 
correcting defective,  downgraded, and declined meetings [p.65].

Email notifications
The templates used to notify organizers are found in Cisco TMS. However, Cisco TMSXE can inject errors, 
warnings, and informational text into email messages sent by Cisco TMS.

These messages can be modified by the administrator.

Modifying the templates

Avoid removing or changing any text in curly brackets, as these are variables that embed other messages.

All templates are created on first service startup in the Cisco TMSXE configuration folder, by default 
C:\ProgramData\Cisco\TMSXE\Config and all template names start with template_ and a descriptive 
name. Templates for HTML email contain HTML in the filename, not the extension.

To modify a template:

 1. Open the template file in a text or HTML editor that does not automatically alter any of the markup or 
headers.

 2. Edit the contents and/or formatting to your liking. 
 3. Save the modified file without the .sample extension.
 4. Restart the Cisco TMSXE service for the modified template to be applied.

All .sample files are overwritten/reverted to default on each service startup, and missing template files are 
regenerated.
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Backing up, moving, and uninstalling Cisco 
TMSXE
Backing up Cisco TMSXE
Storage of passwords for Exchange, Cisco TMS, and Active Directory is encrypted using the Microsoft 
CryptoAPI.The passwords are encrypted using Cisco TMSXE’s password entropy in combination with the 
encryption Data Protection Scope set to LocalMachine. The passwords can therefore only be decrypted by 
processes running on the server hosting Cisco TMSXE.

This also means that in order to retain encrypted passwords in the configuration, a full backup of Cisco 
TMSXE must include the entire OS of the server. 

However, if retyping  the passwords when reinstalling after a restore is an acceptable option, the backup 
needs only contain the contents of the configuration, storage, and log folders. These files should be copied to 
the new target before reinstalling.

Moving the application to a new server
Whether a server is being decommissioned or you are expanding your deployment and need more hardware 
capabilities, follow the instructions below to carry over the Cisco TMSXE configuration, list of monitored 
systems, and replication states to a new server.

Before you start
The same version of Cisco TMSXE must be used on both servers, and no changes to the configuration must 
be made during the move.

 n If an upgrade is also needed, perform the upgrade on the original server before starting the process of 
moving the application.

 n If configuration changes are planned, perform them on the new server after the move is completed and you 
have verified that the service is running and functional.

 n If the server is part of a clustered deployment, give the new server/node access to the network share that 
holds the cluster's configuration and data files before moving the application. For more information, see 
Installing Cisco TMSXE with service clustering [p.39].

Moving the application
 1. Install Cisco TMSXE on the new server. For instructions, see Performing  a new installation [p.31].
 2. When prompted to start the configuration tool, click Yes.
 3. Starting the configuration tool will create the necessary program data folder structure.
 4. Close the configuration tool.
 5. Stop the Cisco TMSXE Windows service on the original server.
 6. Copy the following folders from the original server:

 l /config
 l /storage
 l /logs
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Their default location is C:\ProgramData\Cisco\TMSXE\. If they have been moved to custom 
locations,you can see these in the Locations tab of the configuration tool on the original server.

 7. On the new server, place the folders in their default location, regardless of their location on the original 
server, and confirm that you want to overwrite the existing folders and files.

 8. Run the configuration tool.
 9. Click OK when receiving notifications that password fields are corrupted.

 10. On the Cisco TMS tab, do the following:
 a. Update the Hostname field if required.

If, for example, you are moving Cisco TMSXE from sharing a server with Cisco TMS, the hostname 
can no longer be "localhost".

 b. Enter the password.
 c. Do not click Save, as this will fail until the Exchange Web Services password has been entered.

 11. Go to the Exchange Web Services tab and do the following:
 a. Enter the password.
 b. Click Save.

 12. Optionally, if you want a custom location for the configuration files:
 a. Go to the Advanced Settings tab.
 b. Modify the file paths as desired.
 c. Click Save.

 13. Close the configuration tool.
 14. Start the Cisco TMSXE service.

After moving the application
Do not reactivate any services related to Cisco TMSXE on the original server after the move.

We strongly recommend removing Cisco TMSXE from the original server, see Uninstalling Cisco TMSXE 
4.1 [p.60] if not decommissioning the server itself. 

Uninstalling Cisco TMSXE 4.1
 1. Log on to the Cisco TMSXE server as an administrator.
 2. Go to Control Panel > Programs and Features.
 3. Right-click Cisco TMSXE and select Uninstall.

Removing Cisco TMSXE from the server
After uninstalling the software:

 1. Delete all data directories, by default:     
 l C:\ProgramData\Cisco\TMSXE\Storage
 l C:\ProgramData\Cisco\TMSXE\Config
 l C:\ProgramData\Cisco\TMSXE\Logs

 2. Delete the registry entry HKEY_LOCAL_MACHINE\SOFTWARE\Cisco\TMSXE.

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 60 of 82

Backing up, moving, and uninstalling Cisco TMSXE



Troubleshooting
This section covers troubleshooting of issues that may arise during installation, configuration, and operation 
of Cisco TMSXE. It also describes how to use the logging features.

Reading the Windows event log
 1. Right-click on Computer in the Start menu, Start screen, Desktop, or Explorer, and select Manage.
 2. Go to Server Manager > Diagnostics > Event Viewer > Applications and Services Logs > Cisco 

TMSXE
 3. Press F5 to update the log pane, which lists information about startup, errors, and location of logs.

How logging works
Cisco TMSXE creates several logs to assist in troubleshooting. The default location for these logs is 
C:\ProgramData\Cisco\TMSXE\Logs. 

The location can be reconfigured using the configuration tool during or after installation, see Configuration 
reference [p.35].

 n TMSXE-log-file.txt logs all activities of the Cisco TMSXE Windows service.
 n TMSXE-conference-history-log-file.txt is a filtered view of the above, logging all conference events.
 n TMSXE-decline-downgrade-log-file_YYYYMMDD.txt is a filtered view of the above, logging all declined 

or downgraded meetings. See Filtered log for declined and downgraded conferences [p.61].
 n TMSXEConfig-log-file.txt logs the activities of the configuration tool.
 n TMSXEService-log-file.txt logs the activities of Cisco TMS Booking Service, the synchronous booking 

proxy. The file will only be generated if Booking Service has been installed and accessed.
 n TMSXEMeetingAnalyzerApplication-log-file.txt logs the activities of Meeting Analyzer. Note that the 

meeting analysis results are in the reports you retrieve from inside of the tool itself. This log contains any 
connection issues and other errors encountered by the tool during operation.

All log files have a   size limit of 5Mb. When this limit is reached:

 n A new file with the same name is created.
 n The old log file is renamed to include the suffix .1.
 n If a .1 file already exists, that file is renamed to .2, and so on.
 n The maximum number of log files to store is 15. When a log file reaches the suffix .15, it will be deleted the 

next time the current log file reaches 5Mb.

Filtered log for declined and downgraded conferences

The log file TMSXE-decline-downgrade-log-file_YYYYMMDD.txt is created every day  by the Cisco 
TMSXE Windows service. This log includes all log entries from TMSXE-log-file.txt that relate to bookings 
that have been:

 n declined by Cisco TMS
 n downgraded by Cisco TMSXE and subsequently booked as Reservation in Cisco TMS.
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A maximum of 20 logs are kept on the server. When 20 logs have been accumulated, the first will be 
overwritten. If you need to retain logs for a longer period of time, create your own backup procedure for these 
logs.

Sample log messages for declines and downgrades:

 n Booking as requested fails: Saving routed conference failed, will try to downgrade 
to reservation only

 n Reservation (downgrade) successful: Conference successfully downgraded to 
Reservation Only

 n Reservation fails: Failed to reserve all systems for conference
 n Booking declined: Conference with single TMS participant declined

Turning on debug logging
The default log level is informational. For debugging purposes, doing the following will change the log level:

 1. Open Notepad or another text editor as an administrator.
 2. Locate the Cisco TMSXE Config folder on your computer, by default located in 

C:\ProgramData\Cisco\TMSXE\Config. Note that the ProgramData Windows folder is hidden by 
default.

 3. Change the drop-down to look for All Files.
 4. Open the file Log4net.config.
 5. In the line that says <level value ="INFO" />, replace "INFO" with "DEBUG".
 6. Save and close the file.

This setting significantly increases the size of each log. We strongly recommend reverting the log level back 
to "INFO" after debugging. The steps to revert are the same as above.

TMSXE-conference-history-log only has an INFO level and will not be affected by a change to DEBUG.

Logging in a clustered deployment
Although the log location may be placed on a network drive, this location may not be shared; each node must 
have its own logs.

The Log4net.config file is a part of the shared configuration, which means that enabling and disabling debug 
logging automatically affects both nodes.

Installation fails
If installing Cisco TMSXE with Booking Service, installation will fail if:

 n the default site in IIS has been manually deleted.
To solve this problem, manually create a site in IIS and retry the installation.

 n the site is set up only with an HTTPS binding in IIS.
To solve this problem, add an HTTP binding and retry the installation.
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Errors during configuration
Error messages during the Cisco TMSXE configuration process while using the configuration tool generally 
indicate problems connecting to other systems. The initial troubleshooting step should always be verifying 
that all connection details including usernames and passwords are correct.

Untrusted certificates
By default, Cisco TMSXE uses HTTPS for secure communication with Cisco TMS and Exchange Web 
Services.

If, during initial setup, the configuration tool detects that untrusted certificates are presented by one or both of 
these servers, a prompt will notify you of this. 

This prompt also provides the option to Allow Untrusted Certificates, with the caveat that this setting 
should only be used for test environments, as it is not considered safe and cannot be reverted.

For more information on the Cisco TMSXE security model and what is defined as a trusted certificate, see 
Cisco TelePresence Management Suite Extension for Microsoft Exchange Administrator Guide (3.0).

The remote name could not be resolved
If you include the protocol (HTTP or HTTPS) when filling in the Cisco TMS server address, you will get the 
following error message:

"Cannot connect to Cisco TMS using the details provided. Verify that all fields are filled in correctly and save 
again. Error is: The remote name could not be resolved: 'http'."

Remove the protocol from the server address, leaving only the IP address or FQDN, and click Next again to 
validate the settings and proceed with setup.

The Cisco TMS service user account does not belong to a group that has 
"Book on behalf of" permissions

 n Permissions in Cisco TMS are controlled on a group level. You must ensure that the account set up for the 
service user must belong to a group that has the permission "Book on behalf of". See Creating a Cisco 
TMS user for Cisco TMSXE [p.25].

 n This error may also be displayed in the case of incorrect IIS authentication settings on the Cisco TMS 
server.

Mailbox database is temporarily unavailable
If you get the above error message when validating the Exchange Web Services settings during 
configuration, Cisco TMSXE is failing to connect to Exchange.

You may need to restart the Exchange Information Store before retrying the validation step. See the 
Microsoft knowledge base article Services for Exchange Server 2007 or Exchange Server 2010 cannot start 
automatically after you install Exchange Server 2007 and Exchange Server 2010 on a global catalog server 
for more information.
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The Client Access Server version does not match ...
If you get an error message when submitting the Exchange connection details that "The Client Access 
Server version does not match the accessed resource's Mailbox Server version", you have likely changed 
your deployment to use Exchange 2010, but forgotten to update the Exchange server address to be that of 
the 2010 CAS server.

Update the server address and try validating again.

A time zone with the specified ID could not be found
If during validation of Exchange settings you receive an error message saying that connecting to the 
Exchange CAS server was not possible and the message from the server is "A timezone with the specified 
ID could not be found", this error message may indicate a time zone misconfiguration or a missing Windows 
update on the Exchange CAS server or servers.

We recommend always installing the latest cumulative time zone update, the minimum requirement for 
compatibility being the December 2010 cumulative update. 

See the Windows KB article December 2010 cumulative time zone update for Windows operating systems 
for more information and download links.

Unbookable or unlicensed systems
The configuration tool will present an error message if you add one or more systems to Cisco TMSXE that 
are either missing licensing for Cisco TMSXE or are not bookable for another reason.

Licensing

To complete configuration and make Cisco TMSXE start up, you must do one of the following:

 n Make sure all systems added to Cisco TMSXE are licensed for Outlook booking per theCisco TMS 
requirements [p.10].

 n Make sure all systems added to Cisco TMSXE are licensed for Outlook booking per the licensing 
requirements, see Cisco TelePresence Management Suite Extension for Microsoft Exchange Installation 
Guide.

 n Remove any unlicensed systems.

Not bookable

An endpoint may not be possible to book for other reasons. For example, an administrator may have disabled 
Allow Bookings in Cisco TMS because the endpoint is undergoing maintenance.

If you try to add an endpoint that is not bookable to Cisco TMSXE, the error message will include the system 
ID of affected endpoint(s).

To complete configuration and make Cisco TMSXE start up, you must do one of the following:

 n Make all affected systems bookable.
 n Remove all systems causing errors from Cisco TMSXE and add the systems back in when they can be 

booked.
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The Cisco TMSXE service does not start
If you receive an error message stating that the service "started and then stopped", the configuration tool is 
probably open. Close the configuration tool and try running the service again.

If this is not the case, look at the event log for the ERROR displayed before the “Shutting down..” message. 
See Reading the Windows event log [p.61].

Other possible reasons the service will not start:

 n The service cannot connect to Exchange Web Services or Cisco TMS anymore
 n The service doesn’t have write permissions to the log folder.
 n Files in the Cisco TMSXE folder are in use. 
 n Configuration is incomplete. Launch the configuration tool, review and fill in all fields, close the tool and try 

running the service again.
 n One or more systems are not possible to book in Cisco TMS. See Unbookable or unlicensed systems 

[p.64].

No bookings are accepted or declined
If no accept/decline messages are received from one or more of the endpoints you are trying to book, auto-
acceptance may not have been turned on for the room mailbox. See Creating mailboxes for Cisco TMS 
endpoints in Exchange [p.26] for detail on setting this option for your version of Exchange.

You may also be running a version of Exchange 2010 older than Service Pack 3, which is the current 
requirement. Forms using scripts, such as the Cisco TelePresence form, were not supported by the 
automatic accept feature in Exchange 2010 up to SP2, and any booking from a client that has such a form 
will be left pending in the room mailbox. To solve this problem, upgrade to Microsoft Exchange SP3.

Bookings not replicating 
If bookings do not replicate neither to or from Exchange:

 n Check the event log for connection issues with Exchange or Cisco TMS. (See Reading the Windows event 
log [p.61].)

 n Verify that the TMSXE service is running.

Also note that Cisco TMSXE can only update room calendars, not organizer calendars. Changes made to a 
booking in Cisco TMS will therefore be viewable in room calendars, but not in the organizer's calendar.

Identifying and correcting defective,  downgraded, and 
declined meetings
When a booking encounters an issue in Cisco TMS, this can result in the meeting being saved as defective, 
downgraded to type Reservation (no routing), or declined as summarized in the table below.
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Root cause Result Resolutions

Meeting is outside of the Cisco TMS 
booking horizon, uses an unsupported 
recurrence pattern, or overlaps with an 
existing meeting.

Declined by 
Cisco TMS

Organizer or administrator must book again with 
valid details. Administrator must align booking 
windows for all resource mailboxes in Exchange 
with general booking window in Cisco TMS. 
Administrator must disallow double booking of 
telepresence rooms in Exchange.

Booking encounters a resource conflict in 
Cisco TMS .

Saved as 
defective by 
Cisco TMS

The organizer or administrator must update the 
booking to eliminate the resource conflict, or free up 
resources and re-save the booking from either 
Outlook or Cisco TMS.

One or more participants (telepresence 
rooms) cannot be scheduled into a 
meeting due to configuration issues such 
as missing software licenses or booking 
permissions, or scheduling with the 
endpoint has been disabled.

Tentatively 
downgraded 
by Cisco 
TMSXE, 
declined by 
Cisco TMS if 
this fails.

The administrator must resolve the configuration or 
license issue and restore the meeting to its original 
type (typically Automatic Connect or One Button To 
Push).

Table 6: Booking issues, causes, and resolutions

Declined and downgraded meetings
Reading the logs

Logs for Cisco TMSXE are available in the default location C:\ProgramData\Cisco\Cisco TMSXE\Logs.

An entry will be created in the TMSXE_decline_downgrade_log_file_YYYYMMDD.txt log for each 
participant that is declined or downgraded. 

Example log entries for typical decline scenarios:

 n 2014-08-19 14:39:50,402 [30] INFO  TMSXEBestEffortCommitter - Saving conference as requested was 
declined (conference can never be booked): Unexpected recurrence pattern frequency type encountered: 
Yearly

 n 2014-08-19 14:39:50,318 [10] INFO  TMSXEBestEffortCommitter - Saving conference as requested was 
declined (conference can never be booked): Number of occurrences must be between 1 and 100.

Re-creating declined meetings

To resolve declined meetings:

 1. Identify the declined meetings using the log.
 2. Do one of the following:

 l Re-create these bookings in Cisco TMS on behalf of the organizers at an available time with a 
supported recurrence pattern.

 l Contact the organizers and ask them to re-create their bookings using Outlook.

Correcting downgraded meetings

When downgrading a meeting, Cisco TMSXE will try to book  all participants as Reservation. Any failing 
participants will be declined, and the meeting will be declined if all participants fail. In the latter case, see the 
procedure for declined meetings.

To correct a downgraded meeting:
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 1. Identify the downgraded meetings and failing participants using the log.
 2. Correct the configuration or license issue for the failing participants.
 3. Using Cisco TMS, re-add the corrected participants to the original bookings.
 4. For each downgraded meeting, change the Type to One Button To Push or Automatic Connect.

Defective meetings
A Defective conference in Cisco TMS has been booked by an external client that encountered a resource 
conflict or routing problem. 

A defective conference retains all properties of the booking request without setting up routing or consuming 
telepresence resources. Until all issues are resolved, Cisco TMS will not initiate a defective conference or 
send it to endpoints.

 n In the case of a routing issue, all endpoints in the booking will be set to Busy for the scheduled time, 
keeping the reservation while the administrator or user resolves the issue.

 n In the rare case of an endpoint reservation conflict, the endpoints will not be set to Busy for the defective 
booking.

Defective conferences can be corrected by the organizer or the administrator:

 n Users who book conferences that are saved as defective  will be notified by email and can resolve most 
issues by changing their request and rescheduling from their client.

 n Administrators can locate and resolve defective conferences in Cisco TMS by going to Administrative 
Tools > Diagnostics > Conference Diagnostics or Booking > List Conferences. 
Conferences that are defective because of configuration errors or a permanent lack of routing resources 
must be resolved by an administrator.

When scheduling a series where only some occurrences have a resource conflict or routing issue, Cisco 
TMS will only store the problematic occurrences as defective, leaving the remaining occurrences unaffected.

Correcting defective meetings

To identify and attempt to correct bookings saved as Defective, we recommend the following procedure:

 1. In Cisco TMS, go to Administrative Tools > Diagnostics > Conferences Diagnostics.
 2. Select all entries.
 3. Click Autocorrect.

Cisco TMS will now attempt to re-save all problematic conferences and series, re-routing any instances 
or series as necessary.

 4. Click Refresh to see an updated status field for each entry. When no more entries are in the Autocorrect 
Pending state, go through any remaining entries one by one to determine what caused the booking to be 
defective and how to resolve it:

 a. Click on the conference title to view the conference information page.
 b. Click on the Event Log tab on the lower half of the conference information page. The log will display 

detail on the routing and/or resource issue.
 c. Click Edit and update the booking properties as required to resolve the issue; typically:

 o If the problem is a temporary lack of bridge resources, the conference must be moved or made less 
resource intensive (remove participants).

 o If the problem is a permanent lack of bridge resources, the environment needs more resources 
before the booking can be resolved.
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The Cisco TMS booking interface will only allow you to save your changes if the changes resolve all 
the booking issues. Meetings cannot be saved as Defective when booking from Cisco TMS itself.

Identifying inconsistencies between Cisco TMS and Cisco 
TMSXE
The Cisco TMSXE Meeting Analyzer, that is  installed alongside Cisco TMSXE on the server, helps 
administrators and support engineers identify discrepancies between bookings in Cisco TMS and Exchange.

Process overview
Running Meeting Analyzer will:

 n get all bookings—conferences from Cisco TMS and meetings from Exchange—that include rooms 
monitored by Cisco TMSXE.

 n compare the properties of each booking between the two sources, highlighting any discrepancies in a 
report.

 n highlight any meetings that exists in only one of the systems.
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The following properties are compared:

 n Whether the meeting is part of a recurrent series (recurrence patterns are not compared)
 n Start time, in UTC
 n End time, in UTC
 n Participants that are systems added to Cisco TMSXE
 n Cisco TMS title/Exchange subject if Include meeting titles in consistency check is enabled

Any meetings that are being replicated while the Meeting Analyzer is running will be shown as erroneous until 
replication has completed.

Best practices
Do not make changes to Cisco TMSXE configuration while Meeting Analyzer is running. Meeting Analyzer 
loads this configuration on startup only.

As running Meeting Analyzer leads to significant load on the server, especially with a large selected date 
range and number of bookings, we strongly recommend that you run Meeting Analyzer:

 n off hours.
 n with the shortest possible date range if urgent troubleshooting is needed during business hours, to reduce 

impact on server performance.

Changing the default configuration
Use the Configuration tab to change the storage location and file name pattern for reports, and default time 
range for consistency checks.

Note that unless you use a variable in the report file name, each new report will overwrite the previous one. 
The default name pattern is BookingConsistencyCheckResult-{{timestamp}}.xml.

You can also enable Include meeting titles in consistency check to make Meeting Analyzer compare 
titles from Cisco TMS with subjects from Exchange.

Performing an immediate check
 1. Start the tool, located in Start > All Programs > Cisco > Cisco TMSXE Meeting Analyzer.
 2. Specify the date range for which to check booking consistency. 

You can use the date picker or type the date directly.
The default date range is 1 month, the maximum date range is 2 years.

 3. Click Run.
Depending on the size of the database, the consistency check may take a long time. When the check is 
complete, a report of bookings with inconsistencies will be displayed as a table with Cisco TMS data on 
the left and Exchange data on the right.
All meetings are displayed as series, and any inconsistency at an instance level will also be flagged on 
the series level.
If there is a participant mismatch, it will be displayed on the side of the system that has a participant with 
no match.

 4. Click the plus sign next to a list entry to drill down and see details.
Inconsistent properties are highlighted in red.

 5. Click Save to store the report before exiting the tool.
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You can access reports from previous consistency checks by going to the Saved Reports tab.

Resolving and avoiding inconsistencies
Should Exchange contain the correct information for a meeting that is missing or incorrect in Cisco TMS, you 
must ask the organizer to re-send the meeting invitation for the information to replicate to Cisco TMS.

One root cause for Cisco TMS and Exchange  becoming out of sync is users updating or cancelling bookings 
in Outlook without sending updates to all participants. Let your users know that sending updates is a best 
practice and required to keep calendars in sync. This is also covered in Cisco TMSXE User Guide.

Re-setting the transaction ID to 0 causes Cisco TMSXE to re-replicate all bookings with Cisco TMS as the 
master. This will resolve most inconsistencies that may arise where Cisco TMS is presumed to be correct.

In the case of the replicator from Cisco TMS to Cisco TMSXE hanging, which would cause a large amount of 
inconsistencies, try restarting the service. If this is not successful, contact your Cisco support 
representative.

Setting up a scheduled task
To perform a regular analysis of booking consistency, we recommend setting up a scheduled Windows task 
using the command-line interface for Meeting Analyzer.

To access the CLI, run BookingConsistencyCheckerCommand.exe. Note that it must be run directly from 
its location, the command may not include the entire file path.

Switch Parameter Description

help — Output a list of supported commands.

noOfDays Integer, maximum 730 The number of days starting from today's date to include in 
the analysis.

filename Complete file name or name pattern 
with a .xml extension

Write to file with either:
 n a given name (report is overwritten on each analysis)
 n a name with the given pattern.

The default name pattern is 
BookingConsistencyCheckResult-{{timestamp}}.xml.

Table 7: Command-line interface reference

For instructions on setting up scheduled tasks in Windows Server 2008 and 2012, see the Microsoft article 
Configure a Scheduled Task Item.

License check fails after reinstalling
If performing a reinstallation rather than an upgrade, the Cisco TMS license check for Cisco TMSXE may fail.

To resolve this, do one of the following:

 n Perform an IIS reset on Cisco TMS. If the setup is redundant, do this on both nodes.
 n Wait 30 minutes before restarting the Cisco TMSXE configuration tool and connecting to Cisco TMS.
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Time zone change caveat
If the Cisco TMSXE server's time zone is modified while the Cisco TMSXE service is running, bookings will 
stop replicating between Cisco TMS and Exchange.

Should this happen, perform the following procedure:

 1. Stop the TMSXE service.
 2. Open the Cisco TMSXE ProgramData folder (default location C:\ProgramData\Cisco\TMSXE\, a hidden 

folder).
 3. Rename the Storage folder to Storage.old.
 4. Restart the TMSXE service.

The Storage folder will be recreated by Cisco TMSXE and booking replication will resume.
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Appendixes
Appendix 1: Configuring Exchange 2010 without mailbox 
impersonation
If not enabling the Mailbox Impersonation setting, which allows the Cisco TMSXE user to impersonate any 
resource mailbox, you must instead:

 n Grant Full Access Permissions to the service user.
 n Apply a throttling policy for Exchange.

Both procedures are described below.

Granting Full Access Permissions to the service user
There are two ways to do grant these permissions.

Using Exchange Management Console:

 1. Use the EMC console tree to navigate to Recipient Configuration > Mailbox and select the mailbox you 
want to configure.

 2. Right-click on the room mailbox and select Manage Full Access Permissions….
 3. Click Add....
 4. Add the previously created Cisco TMSXE service user and click Manage.
 5. Click Finish.

If using the Exchange Management Shell:

Enter the following commands,  replacing [mailbox] with the name of the mailbox you are configuring, @ 
sign and domain not included:

Add-MailboxPermission -identity [mailbox] -User [service user] -AccessRights 
FullAccess.

Repeat one of these procedures for each mailbox.

Applying  the Cisco TMSXE Throttling Policy for Exchange 2010
This section is only relevant to administrators deploying Cisco TMSXE with Exchange 2010.

With Exchange 2010 SP1, Microsoft has enabled the client throttling policy feature by default. For more 
information, see the Microsoft article Understanding Client Throttling Policies.

If no throttling policy has been configured, Microsoft will apply a default policy to all users. The default 
throttling policy is tailored for user load and not for an enterprise application like Cisco TMSXE.

In order for all Cisco TMSXE features to work, a custom throttling policy must be applied to the Cisco 
TMSXE application user.

To apply the Cisco TMSXE throttling policy:

 1. Log in to the Exchange 2010 CAS server.
 2. Open Exchange Management Shell.
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 3. Create a custom throttling policy:
 a. New-ThrottlingPolicy Cisco_TMSXE_ThrottlingPolicy
 b. Set-ThrottlingPolicy -Identity Cisco_TMSXE_ThrottlingPolicy -

EWSFastSearchTimeoutInSeconds 300 -EWSFindCountLimit 6000 -
EWSMaxConcurrency $null -EWSMaxSubscriptions 5000 -EWSPercentTimeInAD 200 
-EWSPercentTimeInMailboxRPC 300 -EWSPercentTimeInCAS 500

 4. Assign the policy to the Cisco TMSXE user:   
 a. $b = Get-ThrottlingPolicy Cisco_TMSXE_ThrottlingPolicy
 b. Set-Mailbox -Identity [service user] -ThrottlingPolicy $b

Note that if you encounter any errors after applying the Cisco TMSXE throttling policy, you can revert back to 
the Microsoft throttling policy, see Restoring the Microsoft Throttling Policy [p.75].

Throttling Policy Parameter Definitions and Values
The default values used in the above steps satisfy most Cisco TMSXE deployments. If your deployment 
requires adjustments, you can adjust the Set-ThrottlingPolicy values and rerun step 3b above.

The  table below describes each of the parameters and values for the Set-Throttling Policy command of 
Exchange 2010 SP1.

Parameter name Description Cisco 
TMSXE 
Default

Note

EWSFastSearchTimeoutInSeconds Specifies the amount of time 
that searches made using 
Exchange Web Services 
continue before they time out. 
If the search takes more than 
the time indicated by the policy 
value, the search stops and an 
error is returned.

300 Each Cisco TMSXE call 
has a default time out of 
180 second. 300 is 
granted since each call 
could be phased out.
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Parameter name Description Cisco 
TMSXE 
Default

Note

EWSFindCountLimit The maximum result size of 
FindItem or FindFolder calls 
that can exist in memory on 
the Client Access server at 
the same time for this user in 
this current process. If an 
attempt is made to find more 
items or folders than your 
policy limit allows, an error is 
returned. 
However, the limit isn't strictly 
enforced if the call is made 
within the context of an 
indexed page view. 
Specifically, in this scenario, 
the search results are 
truncated to include the 
number of items and folders 
that fit within the policy limit. 
You can then continue paging 
into your results set using 
additional FindItem or 
FindFolder calls.

6000 This parameter governs 
the maximum number of 
entries for all requests 
combined at a given time. 
Cisco TMSXE only 
requests for 200 entries to 
be returned.

EWSMaxConcurrency How many concurrent 
connections an Exchange 
Web Services user can have 
against an Exchange server 
at one time. A connection is 
held from the moment a 
request is received until a 
response is sent in its entirety 
to the requestor. 
If users attempt to make more 
concurrent requests than their
 policy allows, the new 
connection attempt fails. 
However, existing 
connections remain valid. The
 EWSMaxConcurrency 
parameter has a valid range 
from 0 through 100 inclusive.

$null Due to the nature of EWS 
notification, you can't 
measure the number of 
concurrent requests. $null 
value is required to 
indicate that no throttling 
is necessary for this 
criteria.
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Parameter name Description Cisco 
TMSXE 
Default

Note

EWSPercentTimeInAD The percentage of a minute 
that an Exchange Web 
Services user can spend 
executing LDAP requests 
(PercentTimeInAD). 
A value of 100 indicates that 
for every one-minute window, 
the user can spend 60 
seconds of that time 
consuming the resource in 
question.

200 The value is higher than 
100 since this counts for 
all concurrent requests at 
any given time.

EWSPercentTimeInMailbox RPC The percentage of a minute 
that an Exchange Web 
Services user can spend 
executing mailbox RPC 
requests 
(PercentTimeInMailboxRPC).

300 The value is higher than 
100 since it counts for all 
concurrent requests at any 
given time.

EWSPercentTimeInCAS The percentage of a minute 
that an Exchange Web 
Services user can spend 
executing Client Access server 
code (PercentTimeInCAS).

500 The value is higher than 
100 since this counts for 
all concurrent requests at 
any given time.

EWSMaxSubscriptions The maximum number of 
active push and pull 
subscriptions that a user can 
have on a specific Client 
Access server at the same 
time. 
If a user tries to create more 
subscriptions than the 
configured maximum, the 
subscription fails, and an 
event is logged in Event 
Viewer.

5000 Set to (2 * the number of 
managed rooms). We 
recommend that you 
allocate a number that 
allows for future growth.

Restoring the Microsoft Throttling Policy
If for any reason you encounter errors applying the Cisco TMSXE throttling policy for Exchange 2010 SP1, 
you can revert back to the default Microsoft throttling policy:

 1. Log in to the CAS server for Exchange 2010.
 2. Open Exchange Management Shell application.
 3. Remove Throttling policy association from Cisco TMSXE application user: Set-Mailbox -Identity 

[service user] -ThrottlingPolicy $null.
 4. Remove the custom policy: Remove-ThrottlingPolicy Cisco_TMSXE_ThrottlingPolicy.
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Appendix 2: Setting up Cisco TMSXE without an Active 
Directory connection
Cisco TMSXE can be used in deployments where the Active Directory domain cannot be reached by Cisco 
TMSXE. 

Note that in this deployment scenario, the information about users available to Cisco TMSXE and Cisco 
TMS will be very limited. 

CAUTION: Before you start deploying Cisco TMSXE in this mode, consult with your Cisco account team. 
This mode of operation is only recommended for scenarios with very particular requirements. Once 
operational, the setting cannot be reverted without data loss.

Booking ownership
Cisco TMSXE passes the email address of the organizer to Cisco TMS, which will attempt to resolve this to 
the email address of an existing user. Booking ownership will then be assigned as follows:

 n If the email address matches an existing user, that user will own the booking.
 n If no current user matches the address, but AD lookup is enabled and a match is found in AD, the user will 

be added to Cisco TMS as the owner of the booking.
 n If no user matches the address, and no user is found in AD or lookup is not enabled, behavior depends on 

the Cisco TMSXE setting Allow organizers without usernames (Non-AD Mode only):
 l If enabled, Cisco TMS will create a special user based on the email address. This user will not be able to 

log into Cisco TMS, but will have ownership of all bookings made from the same address.
 l If disabled, all meetings booked through Cisco TMSXE from this address will be owned by the service 

user, and not linked to the individual organizer in Cisco TMS.

Installing with Non-AD mode
To be able to run Cisco TMSXE in Non-Active Directory mode, launch the Cisco TMSXE installer by entering 
the following on the command line:

TMSXESetup.msi NONADCONNECTIONMODE=1

Then follow the regular instructions for installation in this document until you get to the configuration stage.

Configuring Non-AD mode
 n On the Exchange Web Services tab of the configuration tool, enable Non-Active Directory Mode.                 

Confirm by clicking Go to Non-AD Mode in the dialog that opens.
 n On the Advanced Settings tab, determine whether to enable Allow organizers without Cisco TMS 

username (Non AD-mode only).
 l Enabling this setting  makes the organizer the owner of the meeting in Cisco TMS. If a user 

corresponding to the organizer's email address does not exist, Cisco TMS will create it.
 l Disabling this setting will make the service user in Cisco TMS the owner of all bookings from Cisco 

TMSXE.
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Cisco Collaboration Meeting Rooms Hybrid
For Cisco Collaboration Meeting Rooms Hybrid to work with Non-AD Mode:

 n Allow organizers without usernames must be enabled.
 n Cisco TMS must be pre-populated with user profiles that correspond to email addresses in Exchange.
 n WebEx Single Sign On must be enabled in Cisco TMS, or each user profile must be pre-populated with 

WebEx credentials.

Productivity Tools will not work in Non-AD Mode.

Limitations
The following restrictions apply when using Non-AD Mode:

 n Only Cisco TMS administrators may update Cisco TMSXE-created bookings from Cisco TMS.
 n If Allow organizers without usernames is enabled, user email addresses must not be changed in Cisco 

TMS, as this will break the connection between user and bookings. 
If AD lookup is not enabled in Cisco TMS, any user can change their own email address. We therefore 
strongly recommend blocking all direct access to Cisco TMS for Cisco TMSXE end users.

 n Productivity Tools are not compatible with Non-AD Mode.

Appendix 3: Monitoring re-replication when upgrading from 
3.0.x
The first time the service is launched after upgrade, a re-replication of all existing bookings in Cisco TMS will 
be performed. 

With a large database, this process may take as long as 3-5 hours, but the application will be operative while 
this is ongoing.

If you want to monitor the re-replication at any stage, you must turn on DEBUG mode for the service log.

See How logging works [p.61] for instructions on locating and using the logs.

When the process has completed, an INFO message with the following statement will be added to the 
service log:

No changes on TMS

Notifications of series, single meetings, and occurrences that have been updated during re-replication, is 
logged in INFO messages. For example, a series or single meeting that did not exist in Exchange and has 
been replicated from Cisco TMS will be logged as "New item saved".

When a telepresence meeting exist in Exchange that does not exist in Cisco TMS, that meeting will be 
deleted. Most deletions are logged as "Deleting item of type", followed by a specification of which type of 
meeting is deleted. However, where several transactions are performed on the same meeting during re-
replication, this may be logged differently.

To find the conference ID, read upwards from the appropriate log message to locate the closest "Cleaning up 
conference" message.

Note that re-replication only affects meetings that have not yet happened. If you see the message "Not 
updating", it means that a discrepancy was discovered that is in the past and will therefore not be corrected.
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Restarting an interrupted upgrade

If the process is interrupted after installation is completed but before the configuration wizard is launched, the 
re-setting of the transaction IDs may not have been performed, and launching the Cisco TMSXE service will 
not initiate a re-replication.

To find out whether the transaction IDs have been reset, look in the configuration log for an INFO message 
containing the statement:

Finished resetting transaction id on all systems

See How logging works [p.61] for instructions on locating and using the logs.

You will also find separate statements for each affected system, including their Cisco TMS system IDs.

If you cannot find these statements, perform the following steps:

 1. Open a command prompt.
By default, the configuration tool is located in C:\Program Files\Cisco\TMSXE\ConfigurationApp.exe

 2. Run the configuration tool using the switches -wizard -resetAllTransactionIds.
The configuration tool starts up.

 3. Follow the instructions in Appendix 3: Monitoring re-replication when upgrading from 3.0.x [p.77] .

The -resetAllTransactionsIds switch 

The -resetAllTransactionIds switch  initiates a one-time cleanup of discrepancies between Cisco 
TMS and Exchange. 

CAUTION: The re-replication process may take a long time to complete and must be performed off-hours, as 
calendars will be out of sync until the process has completed. 

Performing a trial import of existing meetings
When repurposing resource mailboxes that already include upcoming, scheduled meetings, you can use the 
Cisco TMSXE trial import feature to see which meetings will be bookable in Cisco TMS. 

You must not have any systems in Cisco TMSXE prior to running the trial import, and after it has completed, 
Cisco TMS and Cisco TMSXE must both be re-set.

 1. Take a snapshot of the Cisco TMS database using standard SQL tools.
 2. Run the Cisco TMSXE installer with the command line parameter TRIALIMPORT=1.
 3. When the configuration tool launches, configure the Cisco TMS and Exchange connections.
 4. On the Systems tab, add a compiled .csv file of mailbox addresses mapped to the corresponding systems 

in Cisco TMS.
 5. Complete configuration and start the Cisco TMSXE service when prompted.

 l The service stops automatically after the trial import has completed.
 l The decline and downgrade log lets you know which meetings could not be imported and why.
 l Cisco TMS Booking > List Conferences or Administrative Tools > Diagnostics > Conference 

Diagnostics can be used to identify any bookings saved as Defective in Cisco TMS.

To get products into a functional state after a trial import, you have to:

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 78 of 82

Appendixes



 1. Restore the Cisco TMS database snapshot.
 2. Reset Cisco TMSXE:

 a. From the Cisco TMSXE program folder, run  the command ConfigurationApp.exe -
EndTrialImportMode to disable trial import mode without opening the configuration tool itself.

 b. In the Services panel, disable the Cisco TMSXE Windows service.
The service must remain disabled until you are ready to perform a final import.

 c. The systems you added during trial import are stored in the MonitoredSystems.xml file in the Cisco 
TMSXE configuration folder.
 o Keep this file if you will import meetings from the same endpoints mapped to the same mailboxes 

again.
 o Remove the file to be able to import using a different endpoint/mailbox setup.

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 79 of 82

Appendixes



Notices
Technical support
If you cannot find the answer you need in the documentation, check the website at 
www.cisco.com/cisco/web/support/index.html where you will be able to:

 n Make sure that you are running the most up-to-date software.
 n Get help from the Cisco Technical Support team.

Make sure you have the following information ready before raising a case:

 n Identifying information for your product, such as model number, firmware version, and software version 
(where applicable).

 n Your contact email address or telephone number.
 n A full description of the problem.

To view a list of Cisco TelePresence products that are no longer being sold and might not be supported, visit: 
www.cisco.com/en/US/products/prod_end_of_life.html and scroll down to the TelePresence section.

Accessibility notice
Cisco is committed to designing and delivering accessible products and technologies.

You can find more information about Cisco accessibility here:

www.cisco.com/web/about/responsibility/accessibility/index.html

Cisco TelePresence Management Suite Extension for Microsoft Exchange Deployment Guide (4.1)     Page 80 of 82

Notices

http://www.cisco.com/cisco/web/support/index.html
http://www.cisco.com/en/US/products/prod_end_of_life.html
http://www.cisco.com/web/about/responsibility/accessibility/index.html


Document revision history
Date Description

August 
2016

Updated to reflect change done in 'Configuring Clients to Use the Form' section.
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May 
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installation and administrator guides for Cisco TMSXE. 
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RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED 
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL 
RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE 
SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE 
INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE 
SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR 
A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the 
University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating 
system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE 
OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-
NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE 
PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST 
PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS 
MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other 
countries. A listing of Cisco's trademarks can be found at www.cisco.com/go/trademarks. Third party 
trademarks mentioned are the property of their respective owners. The use of the word partner does not imply 
a partnership relationship between Cisco and any other company. (1005R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual 
addresses and phone numbers. Any examples, command display output, network topology diagrams, and 
other figures included in the document are shown for illustrative purposes only. Any use of actual IP 
addresses or phone numbers in illustrative content is unintentional and coincidental.

© 2014 Cisco Systems, Inc. All rights reserved.
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